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Who Should Read This Guide 
This guide is intended for Web site owners, who were provided with access to Plesk control 
panel as part of their shared or dedicated hosting package. 

What's New in This Version of Your Plesk 
Control Panel 

Plesk 8.1 control panel offers you the following new features (compared to Plesk 8.0): 

AWStats support - AWStats is a powerful Web statistics program which creates advanced 
statistical reports by analyzing log files. Now you can choose which statistical package 
(Webalizer or AWStats) to use. 

Backup function enhancements - You can now back up data to and restore them from FTP 
repositories. 

Access to Webmail for mobile users - Now mobile users can work with their mailboxes from 
WAP phones or PDAs. 

Ruby support - Now you can use on your site web applications written in Ruby and Ruby on 
Rails script languages. 

Access to royalty free images and stock photos for your sites - Now, to buy pictures from 
Fotolia at 20 percent discount, you can use a link in your control panel (Domain name > Buy 
Pictures). 
 

Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it. 

Typographical Conventions 
The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information Example 

Special Bold Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the QoS tab. 

C H A P T E R  2  
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 Titles of chapters, sections, and 
subsections. 

Read the Basic Administration 
chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to designate 
a command line placeholder, 
which is to be replaced with a 
real name or value. 

The system supports the so called 
wildcard character search. 

Monospace The names of commands, files 
and directories, and the 
commands you type.  

The license file is located in the 
httpdocs/common/licens
e directory. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

# ls –al /files 
total 14470 

CAPITALS Names of keys on the keyboard. SHIFT, CTRL, ALT 

KEY+KEY Key combinations for which the 
user must press and hold down 
one key and then press another. 

CTRL+P, ALT+F4 

 

 

 
 

Shell Prompts in Command Examples 
Command line examples throughout this guide presume that you are using the Bourne-again 
shell (bash). Whenever a command can be run as a regular user, we will display it with a dollar 
sign prompt. When a command is meant to be run as root, we will display it with a hash mark 
prompt: 

Bourne-again shell prompt $ 

Bourne-again shell root prompt # 

 
 

General Conventions 
 Chapters in this guide are divided into sections, which, in turn, are subdivided into 

subsections. For example, Documentation Conventions is a section, and General Conventions 
is a subsection. 

 When following steps or using examples, be sure to type double-quotes ("), left single-
quotes (`), and right single-quotes (') exactly as shown. 
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Feedback 
If you spot a typo in this guide, or if you have thought of a way to make this guide better, we 
would love to hear from you! 

If you have a suggestion for improving the documentation (or any other relevant comments), try 
to be as specific as possible when formulating it. If you have found an error, please include the 
chapter/section/subsection name and some of the surrounding text so that we could find it 
easily. 

Please submit a report by e-mail to userdocs@swsoft.com. 

mailto:userdocs@swsoft.com
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Logging In to Plesk 
To log in to your Plesk control panel: 

1 Open your web browser, and in the address bar type the URL where your 
Plesk control panel is located (for example, https://your.domain.com:8443). 

2 Press ENTER.  
Plesk login screen will open. 

3 Type the login name and password your provider gave you into the Login and 
Password boxes, respectively.  
Your login name would be your domain name. 

4 If you log in for the first time, select the language for your control panel 
from the Interface language drop-down box.  
If you had previously specified the interface language and saved it in your interface 
preferences, leave the User default value selected. 

5 Click Login. 
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Becoming Familiar with Plesk's Interface 
When you log in to control panel, it can open in either a standard view, a simplified desktop 
view, or a combination of both. 

The standard view is a customary view of the control panel divided into two main areas: 
navigation pane on the left and the main screen where operations are performed on the right. 

 

Figure 1: Standard view of the control panel. 

The desktop view can show site statistics and shortcuts to the operations you frequently 
perform—everything you may need can now be accessible from a single screen. 
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Figure 2: Desktop view of the control panel. 
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Items in the Standard View 
The navigation pane is located on the left. It gives you access to sets of administrative functions: 

 Home. Web site and e-mail administration tools. You will spend most of the time in this 
area. 

 Sessions. Management of your mail users’ sessions in the control panel and FTP 
connections to your host. For more information on managing sessions, refer to Chapter 
Monitoring Connections to Control Panel and FTP Services (on page 98). 

 Log Out. When finished working with control panel, click this icon to end your session. 
 Help Desk. Use it to report your problems to server administrator or provider’s technical 

support. For more information on this feature, refer to chapter Using Help Desk for 
Requesting Assistance From Service Provider (on page 100). 

 Help. Provides context sensitive help. 

Below the Help icon, there is a context help tip area. It provides a brief description of the current 
screen or available operations. When you place the mouse pointer over a system element or 
status icon, it displays additional information. 

To navigate through Plesk, you can also use a path bar: a chain of links that appears in the right 
part of the screen, below the banner area. To return to a previous screen, use the  Up Level 
icon in the upper-right corner of the screen. 

To find items in lengthy lists, use search boxes located above every list of items: type a search 
criterion into the input box, and click Search. A list will show the items matching the search 
criteria. To return back to viewing all items, click Show All.  

To sort a list by a certain parameter in ascending or descending order, click on the parameter's 
title in the column heading. The order of sorting will be indicated by a small triangle displayed 
next to the parameter's title. 

To customize your control panel in the Standard view, refer to the Customizing Your Control 
Panel in the Standard View (on page 16) section. 

Items in the Desktop View 
The desktop view originally shows three sections: 

 Tools. This group shows shortcuts to the operations that you can perform through the 
control panel. You can freely add and remove these shortcuts. 

 Statistics. This shows the number of e-mail accounts you have under your domain, disk 
space and montly bandwidth usage, and number of served subdomains (parts of your main 
site or separate sites under your parent domain). 

 Favorites. This group shows three types of shortcuts sorted by type and placed on the 
respective tabs. The Mailnames tab shows shortcuts to the favorite e-mail accounts. The 
Shortcuts tab shows all other types of shortcuts that do not relate to e-mail user accounts. 
The Recent tab shows last ten control panel screens you have been on. The Favorites group 
also provides search tool for finding e-mail accounts. To use the search tool, type the search 
criteria (this can be any combination of symbols, search is case insensitive) and click  
Search.    
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To customize your control panel in the Desktop view, refer to the Customizing Your Control 
Panel in the Desktop View (on page 18) section. 

Using Wizards 

When you work with Plesk in the Desktop view, you accomplish the tasks you need through 
wizards. Each wizard is a series of consecutive screens. To accomplish a task using a wizard, 
follow the instructions displayed on the wizard screens. For information on individual options, 
refer to the respective sections of this guide. 

Changing Your Contact Information and 
Password 

If you need to update your contact information, or change password: 

1 Click the  Domain Administrator icon in the Tools group. 
2 Update your information as required, or type a new password, and click OK.  

 

If you forgot your password: 

1 In your web browser’s address bar, type the URL where your Plesk control 
panel is located. For example, https://your.domain.com:8443. 

2 Press ENTER.  
Plesk login screen will open. 

3 Click the Forgot your password? link. 
4 Type your domain name into the Login box, and type your e-mail address 

registered in the system into the E-mail box.  
5 Click OK.  

Your password will be sent to your e-mail address. 
 

https://your.domain.com:8443/
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Customizing Your Control Panel in the 
Standard View 

Setting Interface Language and Skin for Your Control Panel 
To select an interface language and theme (skin) for your control panel: 

1 On your Home page, click the  Domain Administrator icon in the Tools 
group. 

2 In the Preferences group, select the desired interface language and skin from 
the respective drop-down boxes.  
Plesk’s interface has been translated to a number of different languages, so if you do not see 
your own language in the list, ask your provider to install the respective language pack. You 
can also change your contact information here. For instructions on how to change your 
contact information, refer to the Changing Your Contact Information (on page 15) section. 

3 Click OK. 
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Adding a Hyperlink Button to Your Control Panel 
To add a custom hyperlink button to your Plesk control panel: 

1 Click the  Custom Buttons icon in the Tools group. 
2 Specify properties of the button: 

 Type the text that will show on your button in the Button label field. 

 Choose the location for your button. To place it in the right frame of your Home page, 
select the Domain Administration page value as the location. To place it in the left frame 
(navigation pane) of your control panel, select the Navigation pane value. 

 Specify the priority of the button. Plesk will arrange your custom buttons on the control 
panel in accordance with the priority you define: the lower the number – the higher is 
priority. Buttons are placed in the left-to-right order. 

 To use an image for a button background, type the path to its location or click Browse to 
browse for the desired file. It is recommended that you use a 16x16 pixels GIF or JPEG 
image for a button to be placed in the navigation pane, and 32x32 pixels GIF or JPEG 
image for buttons placed in the main frame. 

 Type the hyperlink of your choice to be attached to the button into the URL field. 

 Using the check boxes, specify whether to include the data, such as domain id and 
domain name to be transferred within the URL. These data can be used for processing 
by external web applications. 

 In the Context help tip contents input field, type in the help tip that will be displayed 
when you hover the mouse pointer over the button. 

 Select the Open URL in the Control Panel checkbox if you wish the destination URL to be 
opened in the control panel's right frame, otherwise leave this checkbox unchecked to 
open the URL in a separate browser window. 

 If you wish to make this button visible to the mailbox users with access to control panel, 
select the Visible to all sub-logins checkbox. 

3 Click OK to complete creation. 

 
 

Removing a Hyperlink Button from Your Control Panel 
To remove a hyperlink button from your Plesk control panel: 

1 Click the  Custom Buttons icon in the Tools group. 
2 Select a check box corresponding to the button that you wish to remove and 

click  Remove Selected. 
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Customizing Your Control Panel in the 
Desktop View 

To add or remove items from the desktop: 

1 Click the  Desktop icon in the navigation pane. 
2 Click the  Customize my desktop icon. 
3 In the Tools group, specify what tasks you would like to accomplish through 

the control panel. The appropriate shortcuts will be placed to the desktop. 
The Selected tasks list shows the tasks for which shortcuts are already placed 
on the desktop. The Available tasks list shows the tasks for which you do not 
yet have shortcuts on your desktop. 
 To add a shortcut to the desktop, select the required tasks in the Available tasks list and 

click Add >>. 

 To remove a shortcut from the desktop, select the task that you do not need in the 
Selected tasks list and click << Remove. 

4 To show your custom buttons on the desktop, select the Custom buttons check 
box. 

5 To show the shortcut for creating new custom hyperlink buttons at the 
bottom of the desktop, select the Create a new domain custom button check box. 

6 Specify whether to show the Statistics and Favorites group and what items to 
show there. Deselecting check boxes will remove the respective items from 
the desktop. The Favorites group shows the links to items or control panel 
screens that you added to desktop by navigating to the respective control 
panel screens and clicking the  Create shortcut or  Add to favorites icons. 

7 Click OK. 

 

To add a mail account to the Favorites group of the desktop: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the mail name you want to add to favorites. 
3 Click the  Add to favorites icon at the upper right corner of the screen. 
4 Specify the desktop shortcut label and the description. 
5 Click OK. 

 

To add items to the Favorites group of the desktop: 

1 Navigate to the control panel screen you need. 
2 Click the  Create shortcut icon at the upper right corner of the screen. 
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3 Specify the desktop shortcut label and the description. 
4 Click OK. 

 

To remove items from the Favorites group of the desktop: 

1 On the desktop, click the shortcut that you wish to remove. 
2 Click the  Edit Favorites icon in the upper right corner of the screen. 
3 Click Remove. 

OR 

1 On the desktop, click the  icon corresponding to the shortcut that you wish 
to remove. 

2 Click Remove. 
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To review or select the hosting features available for your account (if your provider delegated 
the permission to manage the hosting options for your account): 

1 Click the  Setup on your Home page. 
2 View or change your hosting options: 

 IP Address. Your domain can be hosted on either exclusive IP address or shared IP 
address. Choose an address from your service provider's IP addresses pool. 

 Certificate. Shows the SSL certificate used by your site. 
 SSL support. Secure Sockets Layer encryption is generally used for protecting transfer 

of sensitive data during online transactions on e-commerce Web sites that run on 
dedicated IP addresses. SSL certificates that participate in the encryption process are 
usually applied to a single domain name on a single IP address, therefore, each site that 
needs SSL protection must be hosted on a dedicated IP address. An exception to this is 
subdomains, which you can protect with a wildcard certificate. Installing an SSL 
certificate on a Web server that hosts several web sites with different domain names on a 
single IP address (shared or name-based hosting) is technically possible, however, it is 
not recommended: the encryption will be provided, but users will get warning messages 
on attempt to connect to the secure site. To allow SSL encryption for Web sites, select 
the SSL support check box. 

 Use a single directory for housing SSL and non-SSL content. By default, when users 
publish their sites through their FTP accounts, they need to upload the web content that 
should be accessible via secure connections to the httpsdocs directory, and the 
content that should be accessible via plain HTTP, to the httpdocs directory. For the 
convenience of  publishing all content through a single location – httpdocs directory, 
select the Use a single directory for housing SSL and non-SSL content check box. 

 FTP login and FTP password. Specify the user name and password that will be used for 
publishing the site to the server through FTP. Retype the password into the Confirm 
Password box. 

 Hard disk quota. Specify the amount of disk space in megabytes allocated to the web 
space for this site. This is the so-called hard quota that will not allow writing more files 
to the web space when the limit is reached. At attempt to write files, users will get the 
"Out of disk space" error. Hard quotas should be enabled in the server's operating 
system, so if you see the "Hard disk quota is not supported" notice to the right of the 
Hard disk quota field, but would like to use the hard quotas, contact your provider or the 
server administrator and ask to enable the hard quotas. 

 Shell access to server with FTP user's credentials. This allows you to upload securely 
web content to the server through a Secure Socket Shell connection, however, allowing 
shell access also poses a potential threat to the server security, so we recommend that 
you do not allow shell access. Leave the Forbidden option selected. 

C H A P T E R  5  
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 FrontPage support. Microsoft FrontPage is a popular web site authoring tool. To enable 
users to publish and modify their sites through Microsoft FrontPage, select the 
FrontPage support and FrontPage over SSL support check boxes, set the FrontPage 
authoring option to enabled, and specify the FrontPage Administrator's login and 
password. 

 Support for programming and scripting languages supported by your hosting 
environment. Specify which of the following  programming and scripting languages 
should be interpreted, executed or otherwise processed by the web server: Active Server 
Pages (ASP), Server Side Includes (SSI), PHP hypertext preprocessor (PHP), Common 
Gateway Interface (CGI), Fast Common Gateway Interface (FastCGI), Perl, Python, and 
ColdFusion. 

 Web statistics. To allow you to view the information on the number of people visited 
your site and the pages of the site they viewed, select the Web statistics and accessible 
via password protected directory /plesk-stat/ check boxes. This will install the Webalizer 
statistical software, which will generate reports and place them into the password 
protected directory. You will then be able to access Web statistics at the URL: 
https://your-domain.com/plesk-stat/webstat using your FTP account login and password. 

 Custom error documents. When visitors coming to your site request pages that the web 
server cannot find, the web server generates and displays a standard HTML page with an 
error message. If you wish to create your own error pages and use them on your web 
server, select the Custom error documents check box. 

3 Click OK. 

  

In This Chapter 
 

 

To view the amounts of resources your Web site and e-mail accounts can consume: 

1 Click the  Limits icon on your Home page. 
2 The resource allotments are listed as follows: 

 Maximum number of subdomains. The number of subdomains that can be hosted under 
your domain. 

 Maximum number of domain aliases. The number of additional alternative domain names 
that you can use for your site. 

 Disk space. The total amount of disk space allocated to your hosting account. This 
amount is measured in megabytes. It includes disk space occupied by all files related to 
this domain/web site: web site contents, databases, applications, mailboxes, log files and 
backup files. This is the so-called soft quota: when it is exceeded, domain names and 
web sites are not suspended automatically, only the appropriate notices are sent to your 
provider's e-mail addresses and the resource overage is indicated by a corresponding 
icon  shown in the control panel to the left of your domain name. When your web site 
starts growing and requires more disk space, consider upgrading your hosting plan. 

https://your-domain.com/plesk-stat/webstat
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 Maximum amount of traffic. Displays the amount of data in megabytes that can be 
transferred from your web site during a month. Once the limit is reached, the appropriate 
notices are sent to your provider's e-mail addresses and the resource overage is indicated 
by a corresponding icon  shown in the control panel to the left of the domain name. 
When your web site starts attracting more visitors and requires more bandwidth, 
consider upgrading your hosting plan. 

 Maximum number of web users. Shows the number of personal web pages that you can 
host for other users under your domain. This service is mostly used in educational 
institutions that host non-commercial personal pages of their students and staff. These 
pages usually have web addresses like http://your-domain.com/~username. If the Allow 
the web users scripting check box is selected, execution of scripts embedded in personal 
web pages is allowed. See the Hosting Personal Web Pages on Your Web Server (on 
page 55) section for details. 

 Maximum number of databases. Displays the number of databases that can be hosted in 
your domain. 

 Maximum number of mailboxes. Shows the number of mailboxes that can be hosted in 
your domain. 

 Mailbox quota. Displays the amount of disk space in kilobytes that is allocated to each 
mailbox in your domain.  

 Maximum number of mail forwarders. Shows the number of mail forwarders that can be 
used in your domain. 

 Maximum number of mail autoresponders. Displays the number of automatic responses 
that can be set up in your domain. 

 Maximum number of mailing lists. Shows the number of mailing lists that you can run in 
a domain. The mailing lists are served by the GNU Mailman software, which may or 
may not be installed on the server. If it is not installed and you would like to use it, ask 
your service provider to install it.  

 Maximum number of Java applications. Displays the maximum number of Java 
applications or applets that you can install in a domain. 

 Validity period. Shows the term for a hosting account. At the end of the term, your 
domain/web site will be suspended, its Web, FTP and mail services will no longer be 
accessible to the Internet users, and you will not be able to log in to the control panel.  

3 Click OK. 

  
 

http://your-domain.com/~username
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To view the permissions for operations you can perform through your control panel: 

1 Click the  Domain Administrator icon on your Home page. 
2 The permissions are listed in the Permissions group: 

 Physical hosting management. Shows whether you can fully control hosting account for 
your web site. If it says No, then you can only change FTP password for accessing your 
web space. 

 FTP password management. Shows whether you are allowed to change your credentials 
for access to web space through FTP. 

 Management of shell access to the server. Shows whether you can access the server 
shell. 

 Hard disk quota assignment. Shows whether you can set up the hard quota on disk space 
allocated to your site. 

 Subdomains management. Shows whether you can set up, modify and remove 
subdomains in your domain. 

 Domain aliases management. Shows whether you can set up additional alternative 
domain names for your web site. 

 Log rotation management. Shows whether you can adjust the cleanup and recycling of 
processed log files for your site. 

 Anonymous FTP management. Shows whether you can have an FTP directory where all 
users could download and upload files without the need to enter login and  password. A 
web site should reside on a dedicated IP address in order to use anonymous FTP service. 

 Crontab management. Shows whether you can schedule tasks with the Crontab task 
scheduler. Scheduled tasks can be used for running scripts or utilities on schedule. 

 DNS zone management. Shows whether you can manage the DNS zone of your domain. 

 Java applications management. Shows whether you can install Java applications and 
applets on your web site through the control panel. 

 Mailing lists management. Shows whether you can use mailing lists provided by the 
GNU Mailman software. 

 Spam filter management. Shows whether you can use spam filter provided by the 
SpamAssassin software. 

 Dr.Web antivirus management. Shows whether you can use server-side antivirus 
protection for filtering incoming and outgoing mail. 

 Backup and restore functions. Shows whether you can use the control panel's facilities to 
backup and restore your site. Scheduled and on-demand backups are supported. 

 User interface. Shows what type of Plesk control panel interface you can use - standard, 
desktop, or both. 

 Desktop management. Shows whether you can customize and manage your desktop 
interface. 

3 Click OK. 
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Once you have registered your domain name, constructed your web site, and purchased a 
hosting package from your hosting service provider, you can: 

 Publish your site to your web space on the provider’s server, 
 Deploy databases and applications that your web server will be using, 
 Secure data transfer with Secure Sockets Layer encryption and restrict access to web server 

resources with password protection. 

 

In This Chapter 
Publishing Your Site ............................................................................................................. 25 
Deploying Databases............................................................................................................. 29 
Installing Applications .......................................................................................................... 33 
Previewing Your Site ............................................................................................................ 35 
Securing Online Transactions on Your Site With Secure Sockets Layer Encryption........... 35 
Customizing DNS Zone Configuration for Your Domain .................................................... 42 
Serving Your Site with External Domain Name Servers ...................................................... 45 
Customizing Web Server Error Messages ............................................................................ 47 
Restricting Access to Web Server's Resources With Password Protection........................... 48 
Organizing Your Site Structure With Subdomains ............................................................... 50 
Setting Up Anonymous FTP Access to the Server ............................................................... 52 
Setting Up Additional Domain Names for a Site (Domain Aliases)..................................... 53 
Hosting Personal Web Pages on Your Web Server .............................................................. 55 
 
 

C H A P T E R  6  

Setting Up and Maintaining Your Web 
Site 



 

 Setting Up and Maintaining Your Web Site 25 
 

Publishing Your Site 
Publishing your site means uploading web pages, scripts and graphic files that compose your 
site to your web space in any of the following ways: 

 Through FTP connection 
 Through Plesk File Manager 
 Through Secure Shell connection (only for users of Linux and FreeBSD operating systems) 
 Through Microsoft FrontPage software (only for users of Microsoft Windows operating 

systems) 

FTP is one of the most common and easiest ways to upload files. 

Uploading Files Through FTP 
To upload files through FTP: 

1 Connect to the server with an FTP client program, using FTP account 
credentials your provider gave you.  
Enable the passive mode if you are behind a firewall. 

2 Upload files and directories that should be accessible through HTTP 
protocol to the httpdocs directory, and files/directories that should be 
transferred securely over SSL protocol to the httpsdocs directory.  

3 Place your CGI scripts into the cgi-bin directory. 
4 Close your FTP session. 

 
 

Changing Your FTP Account Credentials 

To change the user name and password for accessing your FTP account: 

1 On your Home page, click the  Setup icon in the Hosting group. 
2 Specify the new FTP login name and password. 
3 Click OK. 
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Uploading Files Through Plesk File Manager 
To upload files through Plesk File Manager: 

1 Log in to Plesk control panel into your domain administrator’s account. 

2 Click the  File Manager icon in the Hosting group. 
3 Create and upload files and directories.  

Place the files and directories that should be accessible via HTTP protocol to the 
httpdocs directory, and files/directories that should be transferred securely over SSL 
protocol to the httpsdocs directory. Place your CGI scripts into the cgi-bin directory. 

 To create a new directory within your current location, click the  Add New Directory 
button. 

 To create new files in the required directory, click  Add New File, in the File creation 
section specify the file name, select the Use html template check box, if you want file 
manager to insert some basic html tags to the new file, and click OK. A page will open 
allowing you to enter the content or html-formatted source of a new file. After you are 
done, click OK. 

 To upload a file from the local machine, click  Add New File, specify the path to its 
location in the File source box (or use the Browse button to locate the file), and click OK.  

When you upload web content through File Manager or FTP, your control panel automatically 
sets the appropriate access permissions for files and directories. The permissions are represented 
as three sets of symbols, for example, 'rwx rwx r--'. The first set tells what the owner of the file 
or directory can do with it; the second tells what the user group, the file or directory belongs to, 
can do with the file or directory; the third set indicates what other users (the rest of the world, 
i.e. Internet users visiting a site) can do with the file or directory. R means the permission to 
read the file or directory, W means the permission to write to the file or directory, and X means 
the permission to execute the file or look inside the directory. 

To modify permissions for a file or directory, in the Permissions column, click the respective 
hyperlink representing the set of permissions. Modify the permissions as desired and click OK. 

To edit the source code of a file, click . 

To edit the Web page in the built-in visual editor (available only to users of Microsoft Internet 
Explorer), click . When editing an HTML file, Plesk opens internal WYSIWYG editor by 
default. If you want to edit the source code of the HTML file, click Html. To return back to 
WYSIWYG mode, click Design. 

To view the file, click . 

To rename a file or directory, click . Type in a new name and click OK. 

To copy or move a file or directory to another location, select the required file or directory using 
the appropriate check box, and click  Copy/Move. Specify the destination for the file or 
directory to be copied or renamed to, then click Copy to copy, or Move to move it. 
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To update the file or directory creation date, click  Touch. The time stamp will be updated 
with the current local time. 

To remove a file or directory, select the corresponding check box, and click  Remove 
Selected. Confirm removal and click OK. 

Uploading Files Through SSH Connection 
If your are using a Linux or FreeBSD operating system on your local computer and have access 
to server shell, use the ‘scp’ command to copy files and directories to the server: scp 
your_file_name login@remoteserver.com:path to copy files, and scp –r 
your_directory_name login@remoteserver.com:path to copy entire directories. 

After publishing, you will be able to work with files and directories on your account using SSH 
terminal web application integrated in your Plesk control panel (Home >  SSH Terminal). 

Publishing files from Microsoft FrontPage 
Microsoft FrontPage deals with two kinds of Web sites: disk-based and server-based. In short, a 
disk-based site is a FrontPage Web site you create on your local hard disk and then later publish 
to a Web server. A server-based site is one you create and work with directly on a Web server, 
without the extra step of publishing. This section provides you with instructions on publishing 
only disk-based web sites. 

You can publish disk-based web sites either through FTP or HTTP. If your server is running 
FrontPage Server Extensions, you would publish your site to an HTTP location. For example: 
http://your-domain.com/MyWebSite. If your server supports FTP, you would publish to an FTP 
location. For example: ftp://ftp.your-domain.com/myFolder. 

To find out which publishing method your server supports, contact your hosting company, or 
your IT department. 

After publishing, you can manage your site through FrontPage Server Extensions.  

To access FrontPage Server Extensions management interface: 

1 Log in to Plesk. 

2 To manage a site, which is not protected by SSL, click  FP Webadmin. To 

manage an SSL-enabled site, click  FP-SSL Webadmin. 
3 Type your FrontPage administrator’s login name and password, and click 

OK. 

For instructions on using FrontPage server extensions, see online help (FP Webadmin > Help) or 
visit Microsoft web site.  

Publishing From Microsoft FrontPage Through FTP 

mailto:login@remoteserver.com:path
mailto:login@remoteserver.com:path
http://your-domain.com/MyWebSite
ftp://ftp.your-domain.com/myFolder
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If you are publishing from a computer at work, ask your IT department, help desk, or network 
administrator if you are allowed to publish with FTP beyond a firewall. Also ask if you need to 
install special software that allows you to publish beyond the firewall. 

To publish files through FTP: 

1 Open your FrontPage program. 
2 Open a FrontPage Web site: open File menu and select the Open Site item. 
3 Go to Remote Web site view: click the Web Site tab, and then the Remote Web 

Site button at the bottom of the window. 
4 Set up your Remote Web Site Properties: 

 Click the Remote Web Site Properties button in the upper-right corner of the window. 

 Select FTP as the remote Web server. 

 In the Remote Web site location box, type your host name (e.g., ftp://ftp.your-
domain.com) 

 In the FTP directory box, type your FTP directory if your hosting company provided one. 
Leave it blank if they did not specify one. 

 Select the Use Passive FTP check box if your computer or network is protected by a 
firewall.  

5 Click OK to connect to the remote site.  
The Remote Web site view will show files that you have in your local and remote sites. 

6 Click the Publish Web site button in the lower-right corner of the window. 
 

ftp://ftp.your-domain.com/
ftp://ftp.your-domain.com/
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Publishing From Microsoft FrontPage Through HTTP 

To publish files through HTTP on a server that supports FrontPage Server Extensions: 

1 Open your FrontPage program. 
2 Open a FrontPage Web site: open File menu and select the Open Site item. 
3 Go to Remote Web site view: click the Web Site tab, and then the Remote Web 

Site button at the bottom of the window. 
4 Click the Remote Web Site Properties button in the upper-right corner of the 

window. 
5 On the Remote Web Site tab, under Remote Web server type, click FrontPage or 

SharePoint Services. 
6 In the Remote Web site location box, type the Internet address, including the 

protocol, of the remote Web site that you want to publish folders and files 
to — for example, http://www.your-domain.com — or click Browse to locate 
the site. 

7 Do any of the following:  
 To use Secure Sockets Layer (SSL) for establishing a secure communications channel to 

prevent the interception of critical information, click Encryption connection required 
(SSL). To use SSL connections on your Web server, the server must be configured with 
a security certificate from a recognized certificate authority. If the server does not 
support SSL, clear this check box. Otherwise, you will not be able to publish folders and 
files to the remote Web site. If you are not sure whether your Web site supports SSL, 
check with your Web server administrator or Internet service provider. 

 To remove specific types of code from Web pages as they are being published, on the 
Optimize HTML tab, select the options you want. 

 To change the default options for publishing, on the Publishing tab, select the options 
you want. 

8 Click OK to connect to the remote site.  
The Remote Web site view will show files that you have in your local and remote sites. 

9 Click the Publish Web site button in the lower-right corner of the window. 

 
 

Deploying Databases 
If your web server incorporates data processing applications or is designed to generate web 
pages dynamically, you will likely need a database for storing and retrieving data. You can 
either create a new database for your site or import the data from your previously backed up 
MySQL or PostgreSQL database. 
 

http://www.your-domain.com/
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Creating or Importing a Database 
To create a new database on your hosting account: 

1 On your Home page, click  Databases. 

2 Click  Add New Database. 
3 Enter a name for the database.  

We recommend that you choose a name that starts with a Latin alphabet symbol and 
comprises only alphanumeric and underscore symbols (up to 64 symbols).  

4 Select the database type that you are going to use: MySQL or PostgreSQL. 
Click OK. 

5 To set up database administrator’s credentials, click  Add New Database 
User. 

6 Type a user name and a password that will be used for accessing the 
contents of the database. 

7 Click OK.   

 

To import an existing database: 

1 On your Home page, click  Databases. 

2 Click  Add New Database. 
3 Enter a name for the database.  

We recommend that you choose a name that starts with a Latin alphabet symbol and 
comprises only alphanumeric and underscore symbols (up to 64 symbols).  

4 Select the database type that you are going to use: MySQL or PostgreSQL. 
Click OK. 

5 To set up database administrator’s credentials, click  Add New Database 
User. 

6 Type a user name and a password that will be used for accessing the 
contents of the database. Click OK. 

7 Click the  DB WebAdmin icon in the Tools group.  
An interface to phpMyAdmin (or phpPgAdmin) database management tool will open in a 
separate browser window. 

8 Click on the Query window icon in the left frame. 
9 Click the Import files tab. 
10 Select the text file that contains the data and click Go. 
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11 Click the Insert data from a text file link. 

To manage your databases and their contents, use your favorite MySQL or PostgreSQL client or 
the web based database management tool accessible from Plesk control panel (Home > 
Databases > Database name > DB WebAdmin).  
 

Creating a Database User Account 
If you collaborate with other people on managing your web site and wish to give them access to 
the database, you should create separate user accounts for them. 

To create a database user account:  

1 On your Home page, click the  Databases icon in the Services group. 
2 Click on a database name.  

A list of database users will open. 

3 Click  Add New Database User. 
4 Type a user name and a password that will be used for accessing the 

contents of the database. Click OK. 

 
 

Changing Password for a Database User 
To change password for a database user: 

1 On your home page, click the  Databases icon in the Services group. 
2 Click on a database name.  

A list of database users will open. 

3 Click on the database user’s name. 
4 Type a new password and click OK. 
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Removing a Database User Account 
To remove a database user account:  

1 On your home page, click the  Databases icon in the Services group. 
2 Click on a database name.  

A list of database users will open. 

3 Select a check box corresponding to the user account that you wish to 
remove. 

4 Click  Remove Selected. Next, confirm removing and click OK.  

 
 

Removing a Database 
To remove a database with its contents: 

1 On your Home page, click the  Databases icon in the Services group. 
2 Select a check box corresponding to the database that you wish to remove.  

If the required check box appears grayed out, this means that this database is used by a site 
application and you can remove it only by deinstalling the respective application. 

3 Click  Remove Selected. 
4 Confirm removal and click OK. 
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Installing Applications 
To enhance your web site with valuable features, such as guestbooks, forums, hit counters, 
photo galleries, and e-commerce solutions, you can install the respective applications from 
Plesk Application Vault (Home > Application Vault). The number and variety of available 
applications depend on your provider’s policy and your hosting plan. 

To install an application on your site: 

1 On your home page, click the  Application Vault icon in the Hosting group.  
A list of applications installed on your site will be displayed.  

2 Click  Add New Application icon in the Tools group. 
 A list of site applications available for installation will be displayed. 

3 To specify the site where you want to install and deploy an application, 
select it in the Target domain drop-down box in the upper-right corner of the 
screen. 

4 To specify which application you wish to install, select a radio button 
corresponding to the application of your choice. 

5 Click  Install. 
6 Specify whether you wish to create a hyperlink to the application’s interface 

and place it on your Home page in the control panel. 
7 Specify the installation preferences and other information that may be 

required by the application (the requirements may vary), and click OK, when 
finished. 

8 If you have chosen to create a hyperlink button inside your Plesk control 
panel, specify its properties: 
 Type the text that will show on your button in the Button label box. 

 Choose the location for your button. To place it in the right frame of your Home page, 
select the Domain Administration page value as the location. To place it in the left frame 
(navigation pane) of your control panel, select the Navigation pane value.    

 Specify the priority of the button. Plesk will arrange your custom buttons on the control 
panel in accordance with the priority you define: the lower the number – the higher is 
priority. Buttons are placed in the left-to-right order. 

 To use an image for a button background, type the path to its location or click Browse to 
browse for the desired file. It is recommended that you use a 16x16 pixels GIF or JPEG 
image for a button to be placed in the navigation pane, and 32x32 pixels GIF or JPEG 
image for buttons placed in the main frame. 

 Type the hyperlink to be attached to the button into the URL box. 

 Using the checkboxes, specify whether to include the data, such as domain id and 
domain name to be transferred within the URL. These data can be used for processing 
by external web applications. 
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 In the Context help tip contents input field, type in the help tip that will be displayed 
when you hover the mouse pointer over the button. 

 Select the Open URL in the Control Panel checkbox if you wish the destination URL to be 
opened in the control panel's right frame, otherwise leave this checkbox unchecked to 
open the URL in a separate browser window. 

 If you wish to make this button visible to the e-mail users who you granted access to 
control panel, select the Visible to all sub-logins checkbox. 

 Click OK to complete creation. 

Now the application is installed and you can insert a link to this application into the web pages 
of your site, for example, on your home page. Otherwise, you and your users will have to access 
this application by typing its URL, which can be long enough to remember. 

To access the web interface of an application, do any of the following: 

 Type the URL in your browser. For example: http://your-domain.com/forum/. 

 Go to Home > Application Vault, and click an icon , corresponding to the application. 
 If you chose to add a hyperlink button to your Plesk control panel during installation of an 

application, then on your Home page, click the respective button in the Custom buttons 
group or navigation pane. 

To reconfigure an application or change the application administrator’s password, go to Home > 
Application Vault, and click an icon , corresponding to the application. 

To deinstall an application, go to Home > Application Vault, and select a check box 
corresponding to the application that you no longer need. Then click  Remove Selected. The 
application will be deinstalled and its databases removed from the server. 

Installing Java Web Applications 
In addition to the applications from the Application Vault, you can install Java Web application 
packages in the Web archive format (WAR). These Java applications are not distributed with 
Plesk; therefore you should obtain them separately. 

Note: for Java applications to work, your domain name should resolve properly. 

To install an application: 

1 On your Home page, click the  Tomcat icon in the Services group. 

2 Click the  Enable icon in the Tools group.  
This will start the Tomcat service, which provides an environment for Java code to run in 
cooperation with a web server. 

3 Click  Add New Java Application. 
4 Specify the path to an application package you wish to install, or click 

Browse to navigate to it.  
This can be an application package in WAR format saved on your computer’s hard drive. 

http://your-domain.com/forum/
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5 Click OK. 

Now the application is installed and the respective entry is added to the list of installed Java 
applications (Home > Tomcat).  

To access the web interface of an application, do any of the following: 

 Go to Home > Tomcat, and click a respective hyperlink in the Path column. 
 Type the URL in your browser. For example: http://your-domain.com:9080/storefront/. 

 

To stop, start or restart an application: 

1 Go to Home > Tomcat to open a list of installed applications. 
2 Locate an application on the list, and use the icons in the right part of the 

list to perform the required operations: 
 To start an application, click the icon . 

 To stop an application, click the icon . 

 To restart an application, click the icon . 

 

To deinstall an application, go to Home > Tomcat, and select a check box corresponding to the 
application that you no longer need. Then click  Remove Selected. The application will be 
deinstalled and its databases removed from the server. 

Previewing Your Site 
Once you published your site to your web space, you may want to make sure that it functions 
properly in the actual hosting environment. You can preview your site through your favorite 
web browser, even if the information on your domain name has not yet propagated in the 
Domain Name System. Note that Macromedia Flash and CGI scripts will not work during 
preview. 

To preview your site, on your Home page, click the  Site Preview icon in the Hosting 
group. 

Securing Online Transactions on Your Site 
With Secure Sockets Layer Encryption 

http://your-domain.com:9080/storefront/
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If you are running an e-commerce business, you need to secure transactions between your 
customers and your site. To prevent the valuable data, such as credit card numbers and other 
personally identifiable information from stealing, you should use the Secure Sockets Layer 
protocol, which encrypts all data and transfers them securely over the SSL connection. And 
even if someone intercepts the data for malicious intent, they will not be able to decrypt and use 
them. 

To implement the Secure Sockets Layer protocol on your web server, you should purchase an 
SSL certificate from a reputable certificate vendor (these vendors are called Certificate 
Authorities), and then install this certificate on your site. To enable SSL protection, you must 
host your site on a dedicated IP address, which is not shared among other web sites. 

There are numerous certificate authorities to choose from. When considering one, pay attention 
to reputation and credibility of the CA. Knowing how long they have been in business and how 
many customers they have will help you make the right choice. 

Your Plesk control panel provides facilities for purchasing SSL certificates from GeoTrust, Inc. 
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Obtaining and Installing SSL Certificates from GeoTrust, Inc. 
To purchase an SSL certificate through MyPleskCom online store and secure your site: 

1 On your Home page, click the  Certificates icon in the Services group. A 
list of SSL certificates that you have in your repository will be displayed. 

2 Click  Add New Certificate. 
3 Specify the certificate properties: 

 Certificate name. This will help you identify this certificate in the repository. 

 Encryption level. Choose the encryption level of your SSL certificate. We recommend 
that you choose a value more than 1024 bit. 

 Specify your location and organization name. The values you enter should not exceed 
the length of 64 symbols. 

 Specify the domain name for which you wish to purchase an SSL certificate. This 
should be a fully qualified domain name. Example: www.your-domain.com 

 Enter the domain administrator's e-mail address. 

4 Make sure that all the provided information is correct and accurate, as it will 
be used to generate your private key. 

5 Click the Buy Certificate button.  
Your private key and certificate signing request will be generated — do not delete them. 
MyPlesk.com login page will open in a new browser window. 

6 Register or login to an existing MyPlesk.com account and you will be taken 
step by step through the certificate purchase procedure. 

7 Choose the type of certificate that you wish to purchase. 
8 Click Proceed to Buy and order the certificate.  
9 In the Approver E-Mail drop-down box, please select the correct Approver 

e-mail.  
The approver e-mail is an e-mail address that can confirm that certificate for specific 
domain name was requested by an authorized person. 

Once your certificate request is processed, GeoTrust, Inc. will send you a confirmation e-
mail. After they receive the confirmation from you, they will send the certificate to your e-
mail. 

10 When you receive your SSL certificate, save it on your local machine or 
network. 

11 Return to the SSL Certificates repository (Home > Certificates). 
12 Click the Browse button in the middle of the page and navigate to the 

location of the saved certificate.  
13 Select the saved certificate, and then click Send File.  

This will upload and install the certificate against the corresponding private key. 

http://www.your-domain.com/
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14 Return to your Home page and click the  Setup icon in the Hosting group. 
15 Select the SSL certificate that you wish to install from the Certificate drop-

down box.  
If there is no Certificate drop-down box on the screen, this means that you are on a shared 
hosting account; therefore, you need to upgrade your hosting package and purchase a 
dedicated IP address from your hosting provider. 

16 Select the SSL support check box and click OK. 
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Obtaining and Installing SSL Certificates from Other Certification 
Authorities 

To secure your site with an SSL certificate from certificate authorities other than GeoTrust, Inc.: 

1 On your Home page, click the  Certificates icon in the Services group.  
A list of SSL certificates that you have in your repository will be displayed. 

2 Click  Add New Certificate. 
3 Specify the certificate properties: 

 Certificate name. This will help you identify this certificate in the repository. 

 Encryption level. Choose the encryption level of your SSL certificate. We recommend 
that you choose a value more than 1024 bit. 

 Specify your location and organization name. The values you enter should not exceed 
the length of 64 symbols. 

 Specify the domain name for which you wish to purchase an SSL certificate. This 
should be a fully qualified domain name. Example: www.your-domain.com 

 Enter the domain administrator's e-mail address. 

4 Make sure that all the provided information is correct and accurate, as it will 
be used to generate your private key. 

5 Click the Request button. 
 Your private key and certificate signing request will be generated and stored in the 
repository. 

6 Click the  icon, download the certificate signing request (CSR) file and 
save it on your machine. 

7 Once downloaded, open the file in a text editor, copy the text enclosed in 
lines -----BEGIN CERTIFICATE REQUEST----- and -----END 
CERTIFICATE REQUEST----- to the clipboard. 

8 Using your favorite mail client software, create a new e-mail message and 
paste the text from the clipboard.  

9 Send this message to the Certification Authority that will create an SSL 
certificate in accordance with the information you supplied. 

10 When you receive your SSL certificate, save it on your local machine or 
network. 

11 Return to the SSL Certificates repository (Home > Certificates). 
12 Click the Browse button in the middle of the page and navigate to the 

location of the saved certificate.  
13 Select it, and then click Send File.  

This will upload and install the certificate against the corresponding private key. 

14 Return to your Home page and click the  Setup icon in the Hosting group. 

http://www.your-domain.com/
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15 Select the SSL certificate that you wish to install from the Certificate drop-
down box.  
If there is no Certificate drop-down box on the screen, this means that you are on a shared 
hosting account; therefore, you need to upgrade your hosting package and purchase a 
dedicated IP address from your hosting provider. 

16 Select the SSL support check box and click OK. 

 
 

Creating and Installing Free Self-signed SSL Certificate 
If you do not feel like paying money for SSL certificates, but still need to secure your site, you 
can create a self-signed certificate and install it on your web server. This will provide data 
encryption; however, your customers’ browsers will show warning messages telling that your 
certificate is not issued by a recognized authority. Thus, using self-signed certificates is not 
recommended as it will not instill confidence in customers, and is likely to adversely affect your 
online sales. 

To secure your site with a self-signed SSL certificate: 

1 On your Home page, click the  Certificates icon in the Services group. A 
list of SSL certificates that you have in your repository will be displayed. 

2 Click  Add New Certificate. 
3 Specify the certificate properties: 

 Certificate name. This will help you identify this certificate in the repository. 

 Encryption level. Choose the encryption level of your SSL certificate. We recommend 
that you choose a value more than 1024 bit. 

 Specify your location and organization name. The values you enter should not exceed 
the length of 64 symbols. 

 Specify the domain name for which you wish to generate an SSL certificate. This should 
be a fully qualified domain name. Example: www.your-domain.com. 

 Enter the domain administrator's e-mail address. 

4 Click the Self-Signed button.  
Your certificate will be generated and stored in the repository. 

5 Return to your Home page and click the  Setup icon in the Hosting group. 
6 Select the self-signed SSL certificate from the Certificate drop-down box.  

If there is no Certificate drop-down box on the screen, this means that you are on a shared 
hosting account; therefore, you need to upgrade your hosting package and purchase a 
dedicated IP address from your hosting provider. 

7 Select the SSL support check box and click OK. 

 
 

http://www.your-domain.com/
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Deinstalling a Certificate from Your Site 
To deinstall a certificate from your site and disable SSL protection: 

1 Make sure that the certificate you want to remove is not used at the moment.  

1. On your Home page, click the  Setup icon.  

2. The Certificate drop-down box indicates which SSL certificate is 
currently used.  

3. If the certificate that you want to remove is currently in use, you 
should first release it by selecting another certificate in the Certificate 
drop-down box, and clicking OK.  

2 Remove the certificate from repository.  
1. To permanently remove the certificate from repository, on your 

Home page, click the  Certificates icon in the Services group.  

2. Select a check box corresponding to the certificate that you no 
longer need and click  Remove Selected.  

3. Confirm removal and click OK. 
3 Disable SSL support if you no longer need it.  

1. On your Home page, click the  Setup icon.  

2. Deselect the SSL support check box and click OK. 
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Customizing DNS Zone Configuration for 
Your Domain 

Your control panel automatically creates DNS zone for your domain in accordance with the 
configuration preset defined by your provider. The domain name should work fine with the 
automatic configuration, however if you need to perform custom modifications in the domain 
name zone, you can do that through your control panel. 

To view the resource records in a DNS zone of your domain, click the  DNS icon in the 
Services group. A screen will show all resource records for a given domain.  

To learn about modifying resource records in the DNS zone of a domain alias, refer to the 
Setting Up Additional Domain Names for a Site (Domain Aliases) (on page 53) section. 

Adding Resource Records 
To add a new resource record to the zone: 

1 Click the  DNS icon in the Services group. 
2 Click the Add New Record icon in the Tools group. 
3 Select a resource record type, and specify the appropriate data: 

 For an A record you will need to enter the domain name for which you wish to create an 
A record. If you are simply defining an A record for your domain, then you should leave 
the available field empty. If you are defining an A record for a name server then you 
will need to input the appropriate entry for the given name server (ie. ns1). Then, you 
need to enter the appropriate IP address to which to associate the domain name. 

 For a NS record, you will need to enter the domain name for which you wish to create 
the NS record. If you are defining an NS record for your domain, then you will leave the 
available field blank. Then enter the appropriate name server name in the field provided. 
You will need to enter the complete name (i.e. ns1.mynameserver.com). 

 For a MX record, you will need to enter the domain for which you are creating the MX 
record. For your domain, you would simply leave the available field blank. You will 
then need to enter your mail exchanger, this is the name of the mail server. If you are 
running a remote mail server named 'mail.myhostname.com' then you would simply 
enter 'mail.myhostname.com' into the field provided. You will then need to set the 
priority for the mail exchanger. Select the priority using the drop-down box: 0 is the 
highest and 50 is the lowest. Keep in mind you would also need to add the appropriate A 
record, and/or CNAME if applicable for the remote mail exchange server. 

 For a CNAME record, you will need to first enter the alias domain name for which you 
wish to create the CNAME record. You then need to enter the domain name within 
which you want the alias to reside. Any domain name can be entered. It does not need to 
reside on the same server. 

 For a PTR record you will first enter the IP address/mask for which you wish to define 
the pointer. Then enter the appropriate domain name for this IP to be translated to. 
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 For a TXT record, you will be able to enter an arbitrary text string, which could be a 
description or an SPF record. 

4 Click OK to submit the data. 

 
 

Modifying Resource Records 
To modify the properties of a resource record: 

1 Click the  DNS icon in the Services group. 
2 Click the hyperlink in the Host column corresponding to the resource record 

you want to modify. 
3 Modify the record as required and click OK. 
 

To modify entries in the Start of Authority (SOA) record for a domain: 

1 Click the  DNS icon in the Services group. 

2 Click  SOA Preferences. 
3 Specify the desired values: 

 TTL. This is the amount of time that other DNS servers should store the record in a 
cache. Plesk sets the default value of one day. 

 Refresh. This is how often the secondary name servers check with the primary name 
server to see if any changes have been made to the domain's zone file. Plesk sets the 
default value of three hours. 

 Retry. This is the time a secondary server waits before retrying a failed zone transfer. 
This time is typically less than the refresh interval. Plesk sets the default value of one 
hour. 

 Expire. This is the time before a secondary server stops responding to queries, after a 
lapsed refresh interval where the zone was not refreshed or updated. Plesk sets the 
default value of one week. 

 Minimum. This is the time a secondary server should cache a negative response. Plesk 
sets the default value of three hours. 

4 Click OK. 
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Removing Resource Records 
To remove a resource record from the zone: 

1 Click the  DNS icon in the Services group. 
2 Select a check box corresponding to the record you wish to remove. 
3 Click  Remove Selected. 
4 Confirm removal and click OK. 

 
 

Restoring the Original Zone Configuration 
To restore the original zone configuration in accordance with the configuration preset defined 
by your provider: 

1 Click the  DNS icon in the Services group. 
2 In the IP address drop-down box, select the IP address to be used for 

restoring the zone, specify whether a www alias is required for the domain, 
and click the Default button. The zone configuration will be recreated. 
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Serving Your Site with External Domain Name 
Servers 

If you host a web site on this server and have a standalone DNS server acting as a primary 
(master) name server for your site, you may want to set up your control panel's DNS server to 
function as a secondary (slave) name server: 

1 Click the  DNS icon. 

2 Click the  Switch icon in the Tools group. 
3 Click Add New Record, specify the IP address of the primary (master) DNS 

server, and click OK. 

 

To make the control panel’s DNS server act as a primary for a zone: 

1 Click the  DNS icon. 

2 Click the  Switch icon in the Tools group. The original resource records 
for the zone will be restored. 

 

If you host a web site on this server and rely entirely on other machines to perform the Domain 
Name Service for your site (there are two external name servers - a primary and a secondary), 
switch off the control panel’s DNS service for each site served by external name servers: 

1 Click the  DNS icon. 

2 Click the  Disable icon in the Tools group. Turning the DNS service off 
for the zone will refresh the screen, so that only a list of name servers 
remains. 

Note: The listed name server records have no effect on the system. They are only presented 
on the screen as clickable links to give you a chance to validate the configuration of the 
zone maintained on the external authoritative name servers. 

To validate the configuration of a zone maintained on authoritative name servers: 

1 Click the  DNS icon. 
2 Add to the list the entries pointing to the appropriate name servers that are 

authoritative for the zone: click Add New Record, specify a name server, and 
click OK. Repeat this for each name server you would like to test.  

3 The records will appear in the list. 
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4 Click on the records that you have just created. Plesk will retrieve the zone 
file from a remote name server and check the resource records to make sure 
that domain’s resources are properly resolved.  

5 The results will be interpreted and displayed on the screen. 
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Customizing Web Server Error Messages 
When visitors coming to your site request pages that the web server cannot find, the web server 
generates and displays a standard HTML page with an error message. The standard error 
messages may inform of problems, but they do not usually say how to resolve them or how to 
get the lost visitor on his way, and they also look dull. 

You may want to create your own error pages and use them on your web server. With Plesk you 
can customize the following error messages: 

 400 Bad File Request. Usually means the syntax used in the URL is incorrect (e.g., 
uppercase letter should be lowercase letter; wrong punctuation marks). 

 401 Unauthorized. Server is looking for some encryption key from the client and is not 
getting it. Also, wrong password may have been entered. 

 403 Forbidden/Access denied. Similar to 401; a special permission is needed to access the 
site – a password and/or username if it is a registration issue. 

 404 Not Found. Server cannot find the requested file. File has either been moved or deleted, 
or the wrong URL or document name was entered. This is the most common error. 

 500 Internal Server Error. Could not retrieve the HTML document because of server-
configuration problems. 

 

To configure the Web server to show your custom error pages: 

1 Switch on support for custom error documents through Plesk.  

1. On your Home page, click  Setup, and then select the Custom 
Error Documents check box.  

2. Click OK. 
2 If you access Plesk remotely, connect to your FTP account on the Plesk 

server, and go to the error_docs directory. If you access Plesk locally, go 
to the directory /vhosts/your-domain.com/error_docs/ 

3 Edit or replace the respective files.  
Be sure to preserve the correct file names: 

 400 Bad File Request - bad_request.html 

 401 Unauthorized - unauthorized.html 

 403 Forbidden/Access denied - forbidden.html 

 404 Not Found - not_found.html 

 500 Internal Server Error - internal_server_error.html 

4 Wait for a few hours till your web server is restarted.  
After that, the web server will start using your error documents. 
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Restricting Access to Web Server's 
Resources With Password Protection 

If you have directories in your site that only authorized users should see, restrict access to these 
directories with password protection. 

Protecting a Resource 
To password protect a directory in your site and to specify authorized users: 

1 On your Home page, click the  Directories icon in the Hosting group. 

2 Click  Add New Directory. 
3 Specify the path to the directory that you wish to password protect.  

This can be any directory existing in your site, for example: /private. If the directory 
that you would like to protect has not yet been created, specify the path and the directory 
name – Plesk will create it for you. 

4 Specify in what location (also called document root) your password 
protected directory resides or will reside.  
For example: 

 To protect the httpdocs/private directory, type '/private' in the Directory name 
box and select the Non-SSL check box. 

 To protect the httpsdocs/private directory, type '/private' in the Directory name 
box and select the SSL check box. 

 To protect your CGI scripts stored in the cgi-bin directory, leave the '/' value in the 
Directory name box and select the cgi-bin check box. Make sure there are no white 
spaces after the slash symbol; otherwise, a protected directory will be created with the 
name consisting of white spaces.  

5 In the Header Text box, type a resource description or a welcoming message 
that your users will see when they visit your protected area. 

6 Click OK.  
The directory you specified will be protected. 

7 To add authorized users, click  Add New User. 
8 Specify the login name and password that will be used for accessing the 

protected area.  
The password should be from 5 to 14 symbols in length.  

9 Click OK. 
10 To add more authorized users for this protected resource, repeat the steps 7 

and 8. 
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Adding and Removing Authorized Users 
To add an authorized user of a protected directory: 

1 On your Home page, click the  Directories icon in the Hosting group. 
2 Click on the name of the directory you need. 

3 Click the  Add New User icon. 
4 Specify the login name and password that will be used for accessing the 

protected area.  
The password should be from 5 to 14 symbols in length. 

5 Click OK. 

 

To change password for an authorized user of a protected directory: 

1 On your Home page, click the  Directories icon in the Hosting group. 
2 Click on the name of the directory you need.  

A list of authorized users will open. 

3 Click on the user’s name. 
4 Specify the new password and re-type it for confirmation. 
5 Click OK. 

 

To revoke a permission to access the protected directory from a user: 

1 On your Home page, click the  Directories icon in the Hosting group. 
2 Click on the name of the directory you need.  

A list of authorized users will open. 

3 Select a check box corresponding to the user’s name. 
4 Click  Remove Selected.  
5 Confirm the operation and click OK. 
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Unprotecting a Resource 
To remove password protection and make the resource available to the public: 

1 On your Home page, click the  Directories icon in the Hosting group.  
A list of password protected directories will open. 

2 Select a check box corresponding to the name of the directory, from which 
you want to remove protection. 

3 Click  Remove Selected.  

The protection will be removed and the contents of the directory will be accessible to the public 
without restrictions. 

Organizing Your Site Structure With 
Subdomains 

Subdomains are additional domain names that enable you to: 

 Organize logically the structure of your site, 
 Host additional Web sites or parts of your main Web site on the same server without the 

need to pay for registration of additional domain names. 

An example of using subdomains: 

You have a Web site 'your-product.com' dedicated to promoting your software product. For 
publishing user’s guides, tutorials and list of frequently asked questions, you can organize the 
subdomain 'userdocs' so that your users will be able to access online user documentation directly 
by visiting the domain name 'userdocs.your-product.com'. 

Setting up Subdomains 
To set up a subdomain: 

1 On your Home page, click the  Subdomains icon. 

2 Click the  Add New Subdomain icon. 
3 Type the subdomain name as desired.  

This can be, for example, a topic of your site, organization department, or any other 
combination of letters, numbers and hyphens (up to 63 characters in length). The subdomain 
name must begin with an alphabet character. Subdomain names are case insensitive.   
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4 If this subdomain will hold a part of your own Web site that you manage on 
your own, leave the Use the FTP user account of the parent domain option 
selected. If this subdomain will hold a separate web site that will belong to 
or will be managed by another person, select the Create a separate user account 
for this subdomain option, and specify the login name and password that will 
be used for accessing the web space through FTP and publishing web site 
content. 

5 If this subdomain will require secure transactions, select the SSL support 
checkbox.  
Then, the SSL certificate installed under the parent domain will be used for encrypting 
transactions. By default, when you publish the site, you need to upload the web content that 
should be accessible via secure connections to the httpsdocs directory, and the content 
that should be accessible via plain HTTP, to the httpdocs directory. For your 
convenience, you can choose to publish all content through a single location – httpdocs 
directory. To do this, select the option Use a single directory for housing SSL and non-SSL 
content. 

6 Specify the programming languages in which your web site is developed.  
Otherwise, your web site may not function properly. For example, if your web site is written 
mainly in ASP and uses some applications written in PHP, such as those from the 
Application Vault, select the ASP support and PHP support check boxes. 

7 If you wish to limit the amount of disk space that can be occupied by web 
content under this subdomain, type the desired value in megabytes into the 
Hard disk quota box.  
When the specified limit is exceeded, you will not be able to add files to the web space, and 
editing existing files may corrupt them. 

8 To complete the setup, click OK.  
It may take up to 48 hours for the information on new subdomain to spread in the Domain 
Name System and become available to the Internet users.  

To publish web content to the subdomain’s web space, follow the instruction presented in the 
Publishing Your Site (on page 25) section. 

To preview the web content published under the subdomain, on your Home page, click the 

 Subdomains icon, and then click an icon  corresponding to the subdomain name. 
 

Removing Subdomains 
To remove a subdomain with its web content: 

1 On your Home page, click the  Subdomains icon. 
2 Select a check box corresponding to the subdomain name that you wish to 

remove, and click   Remove Selected. 
3  Confirm removal and click OK.  

The subdomain configuration and its web content will be removed from the server. 
 



 

 Setting Up and Maintaining Your Web Site 52 
 

Setting Up Anonymous FTP Access to the 
Server 

If you host your site on a dedicated IP address, you can set up a directory within the site, where 
other users will be able to anonymously download or upload files through FTP. Once 
anonymous FTP is enabled, the users will be able to log in to the ftp://ftp.your-domain.com with 
the "anonymous" login name and any password. 

To allow anonymous FTP access: 

1 Click the  Anonymous FTP icon in the Hosting group. 

2 To activate anonymous FTP service, click the  Enable icon. 
3 To set up a welcoming message to be displayed when users log in to FTP 

site, select the Display login message check box and type the message text in 
the input field as desired.  
Note that not all FTP clients display welcoming messages. 

4 To allow visitors to upload files to the /incoming directory, select the Allow 
uploading to incoming directory check box. 

5 To allow users to create subdirectories in the /incoming directory, select the 
Allow creation of directories in the incoming directory check box. 

6 To allow downloading files from the /incoming directory, select the Allow 
downloading from the incoming directory checkbox. 

7 To limit the amount of disk space that can be occupied by uploaded files, 
deselect the Unlimited check box corresponding to the Limit disk space in the 
incoming directory option, and specify the amount in kilobytes.  
This is the hard quota: the users will not be able to add more files to the directory when the 
limit is reached. 

8 To limit the number of simultaneous connections to the anonymous FTP 
server, deselect the Unlimited check box corresponding to the  Limit number of 
simultaneous connections option and specify the number of allowed 
connections. 

9 To limit the bandwidth for anonymous FTP connections, deselect the 
Unlimited check box corresponding to the Limit download bandwidth for this 
virtual FTP domain option and enter the maximum bandwidth in kilobytes per 
second. 

10 Click OK. 

 

To modify settings for anonymous FTP server or switch it off: 

1 On your Home page, click the domain name you need. 

ftp://ftp.your-domain.com/
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2 Click the  Anonymous FTP icon in the Hosting group. 

3 Adjust the settings as required and click OK.or click the  Disable icon in 
the Tools group to switch off the anonymous FTP service. 

 
 

Setting Up Additional Domain Names for a 
Site (Domain Aliases) 

If you have registered with a domain name registrar several domain names that you would like 
to point to the same web site that you host on this server, you should set up domain aliases, as 
described in this chapter. 
 

Setting Up a Domain Alias 
To set up a domain alias: 

1 Click the  Domain Aliases icon. 
2 Click the Add Domain Alias icon. 
3 Type the desired domain alias name, for example alias.com.  

Domain aliases can comprise letters, digits and hyphens. Each part of the domain alias 
between dots should not be longer than 63 symbols. 

4 Select the Mail check box, if you want e-mail directed at the e-mail addresses 
under the domain alias to be redirected to the e-mail addresses under your 
original domain name. 
Example: You have an e-mail address mail@yourdomain.com. You have set up an alias for 
your domain name, for example, alias.com. If you want to receive mail to your mailbox 
mail@yourdomain.com when it is sent to mail@alias.com, select the Mail check box. 

5 Select the Web check box. Otherwise, the web server will not serve the web 
content to users coming to your site by typing the domain alias in their 
browsers. 

6 Click OK. 

 

When you set up a domain alias, resource records in its DNS zone are copied from the original 
domain name. This means that if your original domain points to an external mail server, your 
domain alias will point to that mail server too. However, to accept mail for the domain alias, the 
external mail server should be configured accordingly. 
 

mailto:mail@yourdomain.com
mailto:mail@yourdomain.com
mailto:mail@alias.com


 

 Setting Up and Maintaining Your Web Site 54 
 

Modifying Properties of a Domain Alias 
To change the properties of an alias:  

1 Click the  Domain Aliases icon. 
2 Click the alias name you need. 

3 Click the  Preferences icon in the Tools group. 

 

 
 

Removing a Domain Alias 
To remove an alias from a domain:  

1 Click the  Domain Aliases icon. 
2 Select a check box corresponding to the domain alias that you want to 

remove. 
3 Click  Remove Selected. 
4 Confirm removal and click OK. 
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Hosting Personal Web Pages on Your Web 
Server 

You can host on your Web server personal Web pages for individuals who do not need their 
own domain names. This service is popular with educational institutions that host non-
commercial personal pages of their students and staff. 

These pages usually have web addresses like http://your-domain.com/~username, however, you 
can set up personal web pages with alternative web addresses like http://username@your-
domain.com, if you like. 

To accommodate a personal web page on your server, allocate a separate web space and set up 
an FTP account for publishing: 

1 On your Home page, click the  Web Users icon. 
2 Click Preferences. 
3 If you wish to allow access to personal web pages by alternative web 

addresses like http://username@your-domain.com, select the Enable 
webuser@example.com access format check box. 
By default, personal web pages have addresses like http://your-domain.com/~username.  

4 If you wish to allow execution of scripts embedded in personal web pages, 
select the Allow the web users scripting check box. 

5 Click OK.  
The settings you have defined at the steps 3 and 4 are common for all personal web pages 
you might host on your web server. Therefore, you will not need to perform steps 3 and 4 
next time you set up a web space for a personal web page. 

6 Click  Add New Web User. 
7 Specify a user name and password that will be used for accessing the web 

space through FTP and publishing the web page.  
You can use only lowercase alphanumeric, hyphen and underscore symbols in user name. 
The user name should begin with an alphabet character. It cannot contain white spaces. The 
password cannot contain quotation marks, white space, user's login name, and should be 
between 5 and 14 characters in length.   

8 Specify the programming languages that should be supported for the Web 
page.  
For example, if the web page is written in PHP, select the PHP support check box. 

9 If you wish to limit the amount of disk space that can be occupied by the 
Web page content, type the desired value in megabytes into the Hard disk 
quota box.  
When the specified limit is exceeded, the Web page owner will not be able to add files to his 
or her web space. 

http://your-domain.com/~username
http://username@your-domain.com/
http://username@your-domain.com/
http://username@your-domain.com/
mailto:webuser@example.com
http://your-domain.com/~username
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10  Click OK. 

Now you can tell your user the FTP account credentials, so that he or she can publish their web 
page. 
 

Changing FTP Password for a Web Page Owner 
To change FTP password for a web page owner: 

1 On your Home page, click the  Web Users icon. 
2 Click the user name you need. 
3 Type the new password into the New password and Confirm password boxes. 
4 Click OK. 

 
 

Allocating More Disk Space to the Web Page Owner 
To allocate more disk space to the web page owner: 

1 On your Home page, click the  Web Users icon. 
2 Click the user name you need. 
3 Type the amount of disk space in megabytes into the Hard disk quota box. 
4 Click OK. 

 
 

Removing Web Page Owner's Account 
To remove a web page owner’s account together with his or her web page: 

1 On your Home page, click the  Web Users icon. 
2 Select a check box to the right of the user name you wish to remove and 

click  Remove Selected. 
3 Confirm removal and click OK. 

 
 



 

 57 
 

You can use a number of different e-mail services with a single e-mail account. For example, 
you can have an e-mail address that will accept mail as any standard mailbox, forward to a 
number of recipients, and send an automatic response to the original message sender. 

In This Chapter 
Creating Mailboxes ............................................................................................................... 58 
Setting Up Your E-mail Program for Retrieving Mail From Your Mailbox ........................ 59 
Accessing Your Mail From a Web Browser ......................................................................... 61 
Protecting Mailboxes From Spam......................................................................................... 62 
Protecting Mailboxes From Viruses...................................................................................... 67 
Suspending and Unsuspending Mailboxes............................................................................ 69 
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Switching off the Mailbox Service When You Have Decided to Turn Your Account into a 
Mail Forwarder ..................................................................................................................... 70 
Setting Up Mail Forwarding to a Single E-mail Address ..................................................... 71 
Setting Up Mail Forwarding to Multiple E-mail Addresses ................................................. 73 
Removing Mail Forwarders .................................................................................................. 75 
Setting Up Automatic Reply ................................................................................................. 76 
Switching off Automatic Reply ............................................................................................ 78 
Introducing Changes to a Number of Mail Accounts at Once .............................................. 79 
Maintaining Mailing Lists..................................................................................................... 80 
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Using E-mail Services 
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Creating Mailboxes 
If you wish to have an e-mail address associated with your site, like yourname@your-
domain.com, you should create a mailbox. To do this: 

1 On your Home page, click the Mail  icon in the Services group. 

2 Click  Add New Mail Name. 
3 Your domain name is shown to the right of @ sign, so you only need to 

specify the desired name for the mailbox.  
This can be, for example, your first name and last name separated by a dot, a department 
name, or any other text in Latin symbols. The name should be short enough to remember. It 
can comprise alphanumeric, dash, dot and underscore symbols. 

4 Specify a password that you will use for accessing your mailbox. 
5 Make sure that a check mark is present in the Mailbox check box. 
6 Click OK. 

Now your mailbox is created on the provider’s server, and you can set up your favorite e-mail 
program so as to receive and send e-mail messages through your new mailbox. 

To create mailboxes for other users: 

1 On your Home page, click the Mail  icon in the Services group. 

2 Click  Add New Mail Name. 
3 Your domain name is shown to the right of @ sign, so you only need to 

specify the desired name for the mailbox.  
This can be, for example, user’s first name and last name separated by a dot, a department 
name, or any other text in Latin symbols. The name should be short enough to remember. It 
can comprise alphanumeric, dash dot and underscore symbols. 

4 Specify a password that mailbox owner will use for accessing his or her 
mailbox. 

5 Make sure that a check mark is present in the Mailbox check box. 
6 If required, limit the amount of disk space that this mailbox can use. To do 

this, under Mailbox quota select the Enter size option and type the desired value 
in kilobytes. 

7 To allow the mailbox owner to manage his or her mailbox through a mailbox 
administration panel, select the Control panel access check box and specify 
the language for the user’s control panel.   

8 Click OK. 
9 To allow the mailbox owner configure and use spam filter and antivirus, 

click Permissions, select the respective check boxes and click OK. 

mailto:yourname@your-domain.com
mailto:yourname@your-domain.com
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Now, the mailbox is created, and a separate e-mail administration panel has been set up in 
Plesk. To enter it, the mailbox owner should visit the URL https://your-domain.com:8443, type 
his or her e-mail address into the Login box, type the password for the mailbox into the 
Password box, and then click Login. 

Setting Up Your E-mail Program for Retrieving 
Mail From Your Mailbox 

To set up Microsoft Outlook Express: 

1 Open Microsoft Outlook Express. 
2 Go to Tools > Accounts. 
3 Click the Mail tab to open a list of your mail accounts. 
4 Click the Add > button and select the Mail … item. 
5 Enter your name as you want it to appear in any messages you send, and 

click Next >. 
6 Type your e-mail address that you created through Plesk (for example, 

your.name@your-domain.com), and click Next >. 
7 Select the protocol of your incoming mail server.  

Although Plesk supports both POP3 and IMAP protocols, we recommend that you select 
IMAP because this leaves your e-mail on the mail server so that it can later be accessed 
from other locations and by other methods, for example, browser based Webmail. 

8 Specify the mail domain name as the incoming and outgoing mail server (for 
example: mail.your-domain.com), and click Next >. 

9 Type your e-mail address in the Account name box (for example: 
your.name@your-domain.com). 

10 Type your password. This should be the password that you specified during 
creation of the mailbox through Plesk.  

11 Leave the Remember password box checked, if you do not wish to be 
prompted to enter password each time your e-mail program connects to the 
mail server to check for new mail, and click Next >. 

12 To complete setting up your e-mail program, click Finish. 

 

To set up Mozilla Thunderbird: 

1 Open Mozilla Thunderbird. 
2 Go to Tools > Account Settings… 
3 Click Add Account. The Account Wizard will open. 
4 Leave the Email account option selected, and click Next >. 
5 Enter your name as you want it to appear in any messages you send. 
6 Type your e-mail address that you created through Plesk.  

https://your-domain.com:8443/
mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
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For example, your.name@your-domain.com. Click Next >. 

7 Select the protocol of your incoming mail server.  
Although Plesk supports both POP3 and IMAP protocols, we recommend that you select 
IMAP because this leaves your e-mail on the mail server so that it can later be accessed 
from other locations and by other methods, for example, browser based Webmail. 

8 Specify the mail domain name as the incoming and outgoing mail server (for 
example: mail.your-domain.com), and click Next >. 

9 In the Incoming User Name box, specify your full e-mail address (for 
example, your.name@your-domain.com), and click Next >. 

10 Enter the name by which you would like to refer to this account (for 
example, Work Account) and click Next >. 

11 Verify that the information you entered is correct, and click Finish. 
12 Click OK to close the Account Settings wizard. 
 

mailto:your.name@your-domain.com
mailto:your.name@your-domain.com
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Accessing Your Mail From a Web Browser 
You can read your mail and compose new messages even if you are far from your home or 
office computer. To do this, you first need to allow access to the Horde Webmail interface that 
is integrated with your control panel. Then you can work with your mail from any computer 
with Internet connection and Web browser installed, or a WAP-enabled cellular phone or a 
handheld computer (PDA). 

 To allow access to the Webmail interface: 

1 On your Home page, click the  Mail icon. 

2 Click  Preferences. 
3 Select the WebMail check box. 
4 Click OK. 

 

Note: Activation and deactivation of Webmail for your domain involves modifications in DNS 
zone, therefore, there is actually a certain delay present when activating and deactivating 
Webmail due to the speed of DNS registration mechanisms. 

 To access your mailbox through Webmail: 
1 Open a Web browser (or a WAP browser, if you are working from a 

handheld device), and type the URL: http://webmail.your-domain.com, 
where your-domain.com is the name of your domain. Press ENTER. The 
webmail login screen will open. 

2 Type the user name and password that you specified during creation of your 
mailbox and click Log in. 

 
 

http://webmail.your-domain.com/
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Protecting Mailboxes From Spam 
To protect your mailbox from undesirable correspondence, do not publish your e-mail address 
on Internet forums and switch on the server-side spam filter provided by the SpamAssassin 
software. 

When you need to publish your e-mail address, create a disposable e-mail address - e-mail alias 
- for your primary e-mail address, and publish it instead. All messages sent to the e-mail alias 
will come into your mailbox. Once you start getting spam, remove that alias and create another 
one. If you have a mailbox at another domain or mail server, you may want to set up a 
disposable e-mail forwarder. 

We would advise that you do not read spam e-mails when you receive them, just delete them at 
once. Even if you have read them, do not respond to them and do not click those “click here to 
unsubscribe” URLs: spammers will then know that your e-mail address is valid and you will get 
even more spam. 
 

Setting Up Additional Disposable E-mail Addresses for Your Mailbox 
(E-mail Aliases) 

To set up an e-mail alias for a mailbox: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the e-mail address you need. 

3 Click  Add New Mail Alias. 
4 Type a desired name and click OK. 

The messages addressed to your additional e-mail address (e-mail alias) will get to your 
mailbox.  

To remove an e-mail alias from a mailbox: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the e-mail address you need. 
3 Select the check box corresponding to the alias that you wish to remove, and 

click  Remove Selected. 
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Setting Up Spam Filter 
If you receive undesirable correspondence to an e-mail address that you cannot or do not want 
to remove, consider setting up spam filter for your mailbox. To do this, 

 Enable SpamAssassin spam filter on your hosting account, if supported by your provider, 
and 

 Install spam filtering software of your choice to work with e-mail program on your home or 
office computer. Mozilla Thunderbird mail program, for example, comes with a nice junk 
filter. 
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Switching on Spam Filter 

To switch on spam filtering for a mailbox: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the e-mail address you need. 

3 Click the  Spam Filter icon in the Tools group. 
4 Configure the following settings as desired: 

 The score required before a mail is considered spam. This setting adjusts spam filter 
sensitivity. SpamAssassin performs a number of different tests on contents and subject 
line of each message. As a result, each message scores a number of points. The higher 
the number, the more likely a message is spam. For example, a message containing the 
text string “BUY VIAGRA AT LOW PRICE!!!” in Subject line and message body 
scores 8.3 points. By default, the filter sensitivity is set so that all messages that score 7 
or more points are classified as spam. 

If you receive lots of spam messages with the current setting, to make filter more 
sensitive, try setting a lesser value in the The score required before a mail is considered 
spam box; for example, 6.  

If you are missing your e-mails because your spam filter thinks they are junk, try 
reducing filter sensitivity by setting a higher value in the The score required before a mail 
is considered spam box. 

Note: To further improve spam filter accuracy, you may want to train your spam filter 
on e-mail messages you receive (see the instructions on improving accuracy of 
spam detection in the following section).  

 What to do with spam mail. If you are sure that your spam filter is accurate, you may 
want to set the filter to automatically delete all incoming messages recognized as spam. 
To do this, select the Delete option. If you wish to filter mail with the software on your 
local computer, select the Mark as spam and store in mailbox option, and then specify 
how spam filter should mark the messages recognized as spam. “X-Spam-Flag: YES” 
and “X-Spam-Status: Yes” headers are added to the message source by default, and if 
you want, the spam filter will also include a specific text string to the beginning of 
Subject line. To include a desired combination of symbols or words to the message 
subject, type it into the Add the following text to the beginning of subject of each message 
recognized as spam box. If you do not want the spam filter to modify message subject, 
leave this box blank. If you want to include into the subject line the number of points 
that messages score, type _SCORE_ in this box. 

5 If you do not want to receive e-mail from specific domains or individual 
senders, click the Black List tab, and then add the respective entries to the 
spam filter’s black list: 
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 To add entries to the black list, click Add Addresses. If you have a list of entries stored 
in a file, click Browse to specify it, and then click OK. Otherwise, select the From List 
option, and type the e-mail addresses into the E-mail addresses box. Place each address 
in one row, or separate addresses with a coma, a colon, or a white space. You can use an 
asterisk (*) as a substitute for a number of letters, and question mark (?) as a substitute 
for a single letter. For example: address@spammers.net, user?@spammers.net, 
*@spammers.net. Specifying *@spammers.net will block the entire mail domain 
spammers.net. To save the entries you added, click OK, then confirm adding, and click 
OK again. 

 To remove entries from the black list, under the Black List tab, select the entries and 
click Remove Selected. Confirm removal and click OK.  

6 If you want to be sure that you will not miss e-mail from specific senders, 
click the White List tab, and then add e-mail addresses or entire domains to 
the spam filter’s white list: 
 To add entries to the white list, click Add Addresses. If you have a list of entries stored 

in a file, click Browse to specify it, and then click OK. Otherwise, select the From List 
option, and type the e-mail addresses into the E-mail addresses box. Place each address 
in one row, or separate addresses with a coma, a colon, or a white space. You can use an 
asterisk (*) as a substitute for a number of letters, and question mark (?) as a substitute 
for a single letter. For example: address@mycompany.com, user?@mycompany.com, 
*@mycompany.com. Specifying *@mycompany.com will add to the white list all e-
mail addresses that are under the mycompany.com mail domain. To save the entries you 
added, click OK, then confirm adding, and click OK again. 

 To remove entries from the white list, under the White List tab, select the entries and 
click Remove Selected. Confirm removal and click OK. 

7 Once finished with setting up the spam filter, click the  Enable Spam 
Filtering  icon, and then click OK. 

 
 

mailto:address@spammers.net
mailto:user?@spammers.net
mailto:*@spammers.net
mailto:*@spammers.net
mailto:address@mycompany.com
mailto:user?@mycompany.com
mailto:*@mycompany.com
mailto:*@mycompany.com
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Improving Accuracy of Spam Detection 

You can improve accuracy of spam detection by training the spam filter on the e-mail messages 
that you have in your mailbox.  

To improve accuracy of spam detection: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the e-mail address you need. 

3 Click the  Spam Filter icon in the Tools group. 
4 Click the Training tab.  

All e-mail messages you have in your mailbox are presented on the screen. Each message is 
accompanied by an icon in the left column, which tells if a message is recognized as spam - 

, non-spam - , or not recognized at all - . If you have already trained your spam filter 
on a message and the results were recorded in the spam filter’s database, an icon  is 
shown in the right column. 

5 Train the spam filter.  
In most cases, you can tell if a message is spam by looking at its subject line and sender’s 
name. If they do not give you any clue, try looking inside the message using your e-mail 
program or Webmail interface. 

 To mark a message as spam, select the corresponding check box and click ‘It’s Spam!’. 
 To mark a message as not spam, select the corresponding check box and click ‘It’s Not 

Spam’. 
 To remove any information on a given message from the spam filter database, select the 

corresponding check box and click ‘Forget It’. 
6 Once finished with training, you can remove spam e-mails from your 

mailbox using your e-mail program or Horde IMP Webmail interface. 
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Clearing Spam Filter's Database 

If you have accidentally made your spam filter learn a great number of spam e-mails as non-
spam or vice versa, your spam filter will likely produce incorrect results. In this case, clear the 
spam filter's database and then repeat training. 

To clear spam filter’s database: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the e-mail address you need. 

3 Click the  Spam Filter icon in the Tools group. 
4 Click the Training tab. 
5 Click the Clear button. 

 
 

Switching off Spam Filter 

To switch off spam filtering for a mailbox: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the e-mail address you need. 

3 Click the  Spam Filter icon in the Tools group. 
4 Click the Disable Spam Filtering icon and then click OK. 

 
 

Protecting Mailboxes From Viruses 
To defend your system from viruses, do not open suspicious e-mail attachments, enable anti-
virus protection on the server side, if this service is provided by your hosting company, and be 
sure to have a firewall and anti-virus software installed on your personal computer. Also keep 
your operating system up-to-date and timely install security hot fixes and patches. 
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Switching on Anti-virus Protection 
 To switch on anti-virus protection for a mailbox: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address you need. 

3 Click the  Dr.Web icon in the Tools group. 
4 Choose the desired mail scanning mode. You can switch on scanning for 

incoming mail, outgoing mail, or both. 
5 Click OK. 

When an infected e-mail message arrives, the appropriate notice is sent to the mailbox owner 
and the message is placed into a quarantine directory on the server. Only the server 
administrator can view infected messages stored in the quarantine directory. 
 

Switching off Anti-virus Protection 
 To switch off anti-virus protection for a mailbox: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address you need. 

3 Click the  Dr.Web icon in the Tools group. 
4 Select the Disabled option and click OK. 
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Suspending and Unsuspending Mailboxes 
 To temporarily suspend e-mail services for a mailbox: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address, whose e-mail services you wish to suspend. 

3 Click the  Mailbox icon in the Tools group. 
4 Clear the Mailbox check box. 
5 Click OK. 

 

 To resume e-mail services for a suspended mailbox: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address, whose e-mail services you wish to resume. 

3 Click the  Mailbox icon in the Tools group. 
4 Select the Mailbox check box. 
5 Click OK. 

 

 To temporarily suspend e-mail services for all mailboxes in your domain: 

1 On your Home page, click the  Mail icon. 

2 Click the  Disable icon in the Tools group. 

 

 To resume e-mail services for all mailboxes in your domain: 

1 On your Home page, click the  Mail icon. 

2 Click the  Enable icon in the Tools group. 
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Removing Mailboxes 
 To remove a mailbox: 

1 On your Home page, click the  Mail icon. 
2 Select a check box corresponding to the mailbox that you wish to remove. 
3 Click  Remove Selected. 
4 When prompted, confirm removal and click OK. 

 
 

Switching off the Mailbox Service When You 
Have Decided to Turn Your Account into a 
Mail Forwarder 

If you are going to use your existing e-mail account as a mail forwarder or mailing list, you are 
recommended to switch off the mailbox service: a mailbox keeps all incoming messages and 
messages are not removed automatically after being forwarded. Therefore, if you choose to have 
the "mailbox + mail forwarder" configuration on your account, be sure to clean up the mailbox 
from time to time. 

 To switch off the mailbox service for your account discarding all messages in your 
mailbox: 

1 On your Home page, click the  Mail icon. 
2 Click the required e-mail address. 

3 Click the  Mailbox icon in the Tools group. 
4 Deselect the Mailbox check box. 
5 Click OK. 
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Setting Up Mail Forwarding to a Single E-mail 
Address 

 To set up an e-mail address that will accept mail and forward it to another e-mail 
address: 

1 On your Home page, click the  Mail icon in the Services group. 

2 Click  Add New Mail Name. 
3 Specify the desired name for the mail forwarder next to Mail name. 

The domain name is shown to the right of @ sign, so you only need to type the name. This 
can be, for example, your first name and last name separated by a dot, a department name, 
or any other text in Latin symbols. The name should be short enough to remember. It can 
comprise alphanumeric, dash dot and underscore symbols. 

4 Clear the Mailbox, Control panel access and Enable spam filtering check boxes. 
5 Click OK. 

6 Click the  Redirect icon in the Tools group. 
7 Select the Redirect check box. 
8 Type the destination e-mail address to which you would like to forward e-

mail. 
9 Click OK.  

 

 To set up an e-mail address that will accept mail, pass it through the spam filter and 
then forward it to another e-mail address:  

1 On your Home page, click the  Mail icon in the Services group. 

2 Click  Add New Mail Name. 
3 Specify the desired name for the forwarder’s e-mail address next to Mail 

Name. 
The domain name is shown to the right of @ sign, so you only need to type the name. This 
can be, for example, your first name and last name separated by a dot, a department name, 
or any other text in Latin symbols. The name should be short enough to remember. It can 
comprise alphanumeric, dash dot and underscore symbols. 

4 Make sure that the Mailbox and Enable spam filtering check boxes are selected.  
Without a mailbox, you will not be able to apply spam filtering. 

5 Specify a password that will be used for accessing the mailbox: You will 
likely need to clean the contents of mailbox from time to time. 

6 Click OK. 
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7 Click the  Redirect icon in the Tools group. 
8 Select the Redirect check box. 
9 Type the destination e-mail address to which you would like to forward e-

mail. 
10 Click OK. 
 

Suspending and Unsuspending Mail Forwarders 
 To suspend a mail forwarder: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address, whose forwarding service you wish to suspend. 

3 Click the  Redirect icon in the Tools group. 
4 Clear the Redirect check box. 
5 Click OK. 

 

 To unsuspend a mail forwarder: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address, whose forwarding service you wish to resume. 

3 Click the  Redirect icon in the Tools group. 
4 Select the Redirect check box. 
5 Click OK. 
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Setting Up Mail Forwarding to Multiple E-mail 
Addresses 

 To set up an e-mail address that will accept mail and forward it to multiple other e-mail 
addresses: 

1 Click the  Mail icon in the Services group. 

2 Click  Add New Mail Name. 
3 Specify the desired name for the mail forwarder next to Mail name. 

The domain name is shown to the right of @ sign, so you only need to type the name. This 
can be, for example, your first name and last name separated by a dot, a department name, 
or any other text in Latin symbols. The name should be short enough to remember. It can 
comprise alphanumeric, dash dot and underscore symbols. 

4 Clear the Mailbox, Control panel access and Enable spam filtering check boxes. 
5 Click OK. 

6 Click  Mail Group. 

7 Click  Add New Member. 
You should add at least one e-mail address before enabling mail forwarding to several e-
mail addresses. 

8 Enter the desired external e-mail address into the E-mail input box  and/or 
select one or more of the local mail accounts listed on the screen. 

9 Click OK. 

10 Click  Enable. 
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Adding and Removing Recipient Addresses 
 To add an external e-mail address to the list of mail accounts that receive forwarded e-

mail correspondence: 

1 Click the  Mail icon in the Services group. 
2 Click the mail forwarder's e-mail address. 

3 Click  Mail Group. 

4 Click  Add New Member. 
5 Enter the desired external e-mail address into the E-mail input box. 
6 Click OK. 

 

 To remove an external e-mail address from the list of mail accounts that receive 
forwarded e-mail correspondence: 

1 Click the  Mail icon in the Services group. 
2 Click the mail forwarder's e-mail address. 

3 Click  Mail Group. 
4 Select the check box corresponding to the e-mail address that you wish to 

unsubscribe. 
5 Click  Remove Selected. 
6 Confirm removal and click OK. 

 

 To add an e-mail address registered on your server to the list of e-mail addresses  that 
receive forwarded e-mail correspondence: 

1 On your Home page, click the domain name you need. 

2 Click the  Mail icon in the Services group. 
3 Click the e-mail address you wish to add to the subscription list. 

4 Click  Groups. 
5 Select the required multiple e-mail forwarder in the Available mail groups list. 
6 Click Add >>. 
7 Click OK. 

An e-mail address registered on your server can also be added to the subscription list using the 
procedure for adding an external e-mail address (see above). 
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 To remove an e-mail address registered on your server from the list of e-mail 
addresses that receive forwarded e-mail correspondence: 

1 On your Home page, click the domain name you need. 

2 Click the  Mail icon in the Services group. 
3 Click the e-mail address that you wish to remove from the subscription list. 

4 Click  Groups. 
5 Select the required multiple e-mail forwarder in the Member of the following 

mail groups list. 
6 Click << Remove. 
7 Click OK. 

An e-mail address registered on your server can also be removed from the subscription list using 
the procedure for removing an external e-mail address (see above). 

Switching off Mail Forwarding to Multiple E-mail Addresses 
To switch off e-mail forwarding to multiple e-mail addresses: 

1 Click the  Mail icon in the Services group. 
2 Click the mail forwarder's e-mail address. 

3 Click  Mail Group. 

4 Click  Disable. 

 
 

Removing Mail Forwarders 
 To remove a mail forwarder: 

1 On your Home page, click the  Mail icon. 
2 Select a check box corresponding to the mail forwarder that you wish to 

remove. 
3 Click  Remove Selected. 
4 When prompted, confirm removal and click OK. 
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Setting Up Automatic Reply 
If you are going on vacation and will not be able to check your mail for a while, you may want 
to leave a vacation notice that will be automatically sent to your correspondents once they send 
e-mail to your address. This is done with automatic reply facility, also referred to as 
autoresponder. Aside from vacation notices, organizations can use automatic replies to notify 
customers that their orders or technical support requests were received and will soon be 
processed. Automatic replies can include prewritten messages in plain text or HTML format, 
and they can contain attached files as well. 

 To set up automatic reply for a mailbox: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address, for which you wish to set up an automatic reply. 

3 Click the  Autoresponders icon in the Tools group. 
4 If you are not going to attach any files to the automatic reply, proceed to the 

step 5. To attach a file to the automatic reply:  

1. Click the  Attachment Files icon in the Tools group.  

2. Click Browse to locate the file, and once selected, click Send File.  
The file will be added to the attachment files storage, and you will be able to attach this 
file to a number of different automatic replies.  

3. Once finished, click  Up Level and proceed to the next step. 

5 Click the  Add New Autoresponder icon in the Tools group. 
6 Configure the automatic reply: 

1. Type a name for this automatic reply into the Autoresponder name 
box.  
For example, 'Vacation notice'. 

2. If you want your incoming mail to be forwarded to another e-mail 
address while you are away, specify an e-mail address in the Upon 
automatic response, forward the original message to the specified e-mail 
box. 

3. If you want this automatic reply to be sent in reply to any incoming 
e-mail message, in the Conditions group, leave the always respond 
option selected. If you wish to automatically reply only to e-mail 
messages that contain specific words in the message text or subject 
line, select the appropriate option, and type the word combination in 
the input box. 
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4. By default, the subject line of incoming e-mail will be inserted into 
the automated reply. To use a custom subject, type it into the Reply 
subject input box. 

5. As your correspondents may not figure out that the message they 
received from you was an automatic response, they may want to 
respond to your auto-reply. So, you should specify your e-mail 
address as the Return address, otherwise, their messages will be 
directed at the autoresponder’s address. 

6. Specify the automatic reply message format (plain text or HTML) and 
character encoding (UTF-8 is recommended). If you use HTML tags 
in your auto-reply message, you should select the HTML option. 

7. Type your message in the Reply with text field. 

8. Attach your files, if needed. To do this, click the  Add New Attachment 
button, select the check box corresponding to the file that you 
previously uploaded to the attachment storage, and click OK. To 
remove an attached file from the automatic reply, select the 
corresponding checkbox, and click  Remove Selected. 

9. To limit the number of automated responses per day to the same e-
mail address, enter the desired number in the respective input box 
under Limits.  
The default setting is to respond no more than ten times in one day to the same e-mail 
address. 

10. To reduce mail server load, you may want to limit the number of 
unique addresses that the autoresponder will remember. To do this, 
enter the desired number into the Store up to box. 

7 Click OK. 

8 Click the  Enable icon in the Tools group. 
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Switching off Automatic Reply 
 To switch off an automatic reply for a mailbox: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address, for which you wish to switch off the automatic 

reply. 

3 Click the  Autoresponders icon in the Tools group. 

4 Click the  Disable icon. 

The automatic reply is now switched off. Its configuration is not deleted from the control panel, 

so the next time you need to use this automatic reply, repeat the above procedure, clicking  
Enable on the last step. 

 To delete an automatic reply configuration that you no longer need: 

1 On your Home page, click the  Mail icon. 
2 Click the e-mail address you need. 

3 Click the  Autoresponders icon in the Tools group. 
4 Select a check box corresponding to the configuration name, and click  

Remove Selected. 
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When somebody sends an e-mail message to an e-mail address that does not exist under your 
domain, the mail server, by default accepts mail, processes it, and when it finds out that there is 
no such a recipient under the domain, it returns the mail back to sender with the “this address no 
longer accepts mail” notice. You can choose to: 

 Change the default notice if you do not like it, 
 Forward all such mail to the desired e-mail address,  
 Reject such mail without accepting it and without notifying senders.  

This setting can decrease mail server load caused by a large amount of spam, which is often 
sent to randomly generated user names. However, for spammers, this can somewhat speed 
up scanning your mail server for valid e-mail addresses. 

 To configure the site-wide settings for serving mail to nonexistent users: 

1 On your Home page, click the  Mail icon. 

2 Click  Preferences. 
3 Choose a desired option and specify the information as required. 
4 Click OK. 

 
 

Introducing Changes to a Number of Mail 
Accounts at Once 

To introduce similar changes to a number of mail accounts at once: 

1 Click the  Mail icon in the Services group. 
2 Select the check boxes corresponding to the mail accounts you wish to 

modify. 
3 Click  Group Operations. 
4 Adjust the settings as desired: 

 Select Enable to enable the respective option for all selected mail accounts. 

 Select Disable to disable the respective option for all mail accounts you selected. 

 Leave Do not change selected for the options you do not want to modify. 

5 Click OK. 
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Maintaining Mailing Lists 
If you wish to deliver offers and promotions to your customers, run a newsletter, or inform 
visitors of your site of recent updates, you should set up a mailing list on your site and subscribe 
your users to it or invite them to subscribe themselves. 

Mailing list is a convenient way to reach a number of readers at once: it contains a list of 
subscribers’ e-mail addresses, which are combined under a single e-mail address, to which you 
post your information or a newsletter. Mailing lists are provided by the GNU Mailman software, 
which may or may not be installed on your server.  

To make sure that you can use mailing lists, contact your provider or look it up in the control 

panel: go to Home > Mail, click the Mailing lists tab, and see if there is an  Add New Mailing 
list icon displayed in color. 
 

Setting Up a Mailing List 
 To set up a mailing list: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the Mailing lists tab. 

3 Click the  Enable icon in the Tools group to start up the Mailman 
software on the server. 

4 Click the  Add New Mailing List icon in the Tools group. 
5 Specify the desired name for the mailing list.  

This can be, for example, a department name, a topic of the mailing list, or any other text in 
Latin symbols. The name should be short enough to remember. It can comprise 
alphanumeric, dash, dot and underscore symbols. 

6 Specify the password that will be used for administering the mailing list. 
7 Specify the mailing list administrator’s e-mail. 
8 Leave the Notify administrator of the mailing list creation check box selected. 

You will receive instructions on using and managing the mailing list at the administrator’s 
e-mail you specified. Keep that message for your records. 

9 Click OK. 
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Configuring Mailing List 
Your mailing list is operable with the default settings. However, you may want to configure it, 
for example, so as to enable moderation, filter content of the posts or to archive messages. To do 
this from the control panel: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the Mailing lists tab. 
3 Click the  icon next to the desired mailing list’s e-mail address.  

A login screen opens. 

4 Type the list administrator’s password and click Let me in …. 

 

Alternately, you can access the mailing list configuration the following way: 

1 In your web browser, enter the following URL: http://lists.<your-
domain.com>/mailman/admin/<listname> (where <your-domain.com> is 
your domain name, and <listname> is the name of the mailing list (i.e. the 
left part of the mailing list’s e-mail address before the @ sign).  
A login screen opens.  

2 Type the list administrator’s password and click Let me in …. 
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Subscribing and Unsubscribing Users 
 To subscribe users to mailing list: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the Mailing lists tab. 
3 Click the mailing list’s e-mail address. 

4 Click  Add New Member. 
5 Specify subscriber’s e-mail address. 
6 Click OK. 

 

 To unsubscribe users from mailing list: 

1 On your Home page, click the  Mail icon in the Services group. 
2 Click the Mailing lists tab. 
3 Click the mailing list’s e-mail address. 
4 Select a check box to the right of the user’s e-mail address. 
5 Click  Remove Selected. 
6 Confirm removal and click OK. 
 

Posting to Your Mailing List 
To post a newsletter issue or other information to the mailing list, send it by e-mail to the 
mailing list’s e-mail address. All subscribed users will receive it. 

Removing Mailing Lists 
 To remove a mailing list from site: 

1 On your Home page, click the  Mail icon. 
2 Select a check box corresponding to the mailbox that you wish to remove. 
3 Click  Remove Selected. 
4 When prompted, confirm removal and click OK. 
 



 

 83 
 

To find out the amount of bandwidth and disk space used by your site, see the Disk Space and 
Traffic rows in the table at the bottom of your Home page. 

 To find out how many people visited a site, from what countries, and what pages of the 
site they viewed: 

1 Click the  Report icon in the Domain group. 
2 View the statistics for the web pages or files downloaded from or uploaded 

to specific areas of your site: 
 To view the statistics for web pages transferred from your site over hypertext transfer 

protocol (HTTP), click  Web Stats. 

 To view the statistics for web pages transferred from your site over secure hypertext 

transfer protocol (HTTPS), click  Web Stats SSL. 

 To view statistics for files transferred over file transfer protocol (FTP), click  FTP 
Stats. 

 To view the bandwidth usage by months, click the  Traffic History icon. 

 To view the bandwidth usage by FTP, Web and mail services in this domain, click the 

 Traffic icon. 

Note: If you use Webalizer statistical package on your account, you can customize the 
graphical reports shown by Webalizer. For instructions, refer to the Adjusting Preferences 
for Web Statistics Presentation by Webalizer (see page 84) section. 

Alternately, you can view the Web statistics for a site by visiting the following URL: 
https://your-domain.com/plesk-stat/webstat. When prompted for username and password, 
specify the credentials for your FTP account. 

Common operations on reports: 

 To get more details, select the Full Report option from the Report drop-down menu. 
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 To adjust the amount of information presented in a report, click the  Customize icon, and 
then modify an existing report template (to do this, click a report template name) or create a 

new report template (to do this, click the  Add New Layout icon). Next, specify how 
much information you want in each section of the report: select None if you do not want any 
information, select Summary if you want a concise overview, or select Full if you need a 
detailed report. Select the Use as default report check box and click OK. To delete a custom 
report layout, select the checkbox corresponding to the report layout name and click  
Remove Selected.  

 To print the report, click the  Print icon. A report will open in a separate browser window. 
Select the File > Print option from the browser's menu to print the report. 

 To send the report by e-mail, type the recipient's e-mail address into the input box located to 
the right of the Report group and click the  Send by E-mail icon. If you are the recipient, 
then you do not need to specify an e-mail address: the system assumes by default that you 
are the report recipient and specifies your e-mail address registered with your control panel 
account. 

 To have the reports automatically generated and delivered by e-mail on a daily, weekly, or 

monthly basis, click the  Report Delivery icon and follow the instructions supplied in 
the Automating Report Generation and Delivery by E-mail (on page 88) section. 

In This Chapter 
Adjusting Preferences for Web Statistics Presentation by Webalizer................................... 84 
Automating Report Generation and Delivery by E-mail ...................................................... 88 
Viewing Log Files and Configuring Recycling of Log Files................................................ 89 

 
 

Adjusting Preferences for Web Statistics 
Presentation by Webalizer 

By default, statistical utility counts and reports the requests for web pages and other files made 
from your own site – by your web pages. So, when a user’s browser requests from your site a 
single web page that contains references to other files, such as scripts, cascading style sheets, 
media files, and the like, the statistical utility reports these references to files as if they were 
visits to your web page. Thus, with the default settings your usage statistics is inaccurate. 

You may want to: 

 Hide these internal references, and references from other sites. 
 Group references from a number of sites, so as to show them as if they originated from a 

single location. 
 Hide direct requests. Direct requests are sent to your web server when users access your site 

by typing the URL in their browsers. 
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Hiding and Unhiding Internal References from Your and Other Sites 
 To hide the internal references or references from other sites: 

1 On your Home page, click  Report. 

2 Click the  Web Statistics Preferences icon. 

3 Click the  Hide Entries icon. 
4 In the Entry type drop-down box, leave the Referrer value selected. 
5 In the Referrer field, type the domain name from which you do not want the 

referrers shown in web statistics reports.  
You can use the '*' wildcard character to specify a part of domain name. 

6 Click OK. 

 

 To unhide references: 

1 On your Home page, click the  Report icon. 

2 Click the  Web Statistics Preferences icon.  
All hidden entries will be presented in a list. 

3 Select the check boxes corresponding to the entries you wish to unhide and 
click Remove Selected. 

4 Confirm the operation and click OK. 
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Grouping and Ungrouping References from Other Sites 
 To group references from a specific site: 

1 On your Home page, click the  Report icon. 

2 Click the  Web Statistics Preferences icon. 
3 Click the Grouped referrers tab. 

4 Click the  Group Referrers icon. 
5 Type the group name that you wish to be shown for all referrers on the 

specific site. 
6 In the Referrer input box, specify the site (domain name) from which all 

referrers should be grouped.  
You can use the '*' wildcard character to specify a part of domain name. 

7 Click OK. 

 

 To ungroup references from a specific site: 

1 On your Home page, click the  Report icon. 

2 Click the  Web Statistics Preferences icon. 
3 Click the Grouped referrers tab.  

All referrer group names will be presented in a list. 

4 Select the check box corresponding to the required group name and click 
Remove Selected. 

5 Confirm the operation and click OK. 
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Hiding and Unhiding Direct Requests 
 To hide direct requests: 

1 On your Home page, click the  Report icon. 

2 Click the  Web Statistics Preferences icon. 

3 Click the  Hide Entries icon. 
4 In the Entry type drop-down box, select the Direct request value. 
5 Click OK. 

 

 To unhide direct requests: 

1 On your Home page, click the  Report icon. 

2 Click the  Web Statistics Preferences icon.  
All hidden entries will be presented in a list. 

3 Select the check box corresponding to the Direct request entry and click 
Remove Selected. 

4 Confirm the operation and click OK. 
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Automating Report Generation and Delivery 
by E-mail 

 To receive detailed reports on your domain on a regular basis: 

1 Click the  Report icon. 

2 Click  Report Delivery. 

3 Click  Add Delivery Schedule. 
4 To receive the report to your e-mail address registered with the system, 

select the the domain administrator value from the Deliver to drop-down menu. 
To receive the report to another e-mail address, select the e-mail address I 
specify option and type the e-mail address.  

5 Select the delivery interval from the Delivery frequency drop-down menu. You 
can have the report delivered each day, each week, or each month. 

6 Click OK. 

 

 To change the delivery schedule for a detailed domain/web site report: 

1 Click the  Report icon. 

2 Click the  Report Delivery icon. 
3 Under the Frequency column, click a hyperlink corresponding to the delivery 

schedule you would like to change. 
4 Adjust the settings as required and click OK. 

 

 To stop receiving the account status reports: 

1 Click the  Report icon. 

2 Click the  Report Delivery icon. 
3 Select a check box corresponding to the delivery schedule and click  

Remove Selected. Confirm removal and click OK. 
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Viewing Log Files and Configuring Recycling 
of Log Files 

All connections to the Web server and requests for files that were not found on the server are 
registered in log files. These log files are analyzed by the statistical utilities running on the 
server, which then present graphical reports on demand. You may want to download these log 
files to your computer for processing by third-party statistical utilities, or view their contents for 
web server debugging purposes. 

To prevent these log files from growing too large, you should enable automatic cleanup and 
recycling of log files.  

 To enable automatic cleanup and recycling of log files: 

1 Click the  Log Manager icon in the Hosting group. 

2 Click the  Log Rotation icon in the Tools group. 

3 Click the  Enable icon in the Tools group. If you see only the  Disable 
icon there, this means that log recycling is already switched on. 

4 Specify when to recycle log files and how many instances of each log file 
processed by Plesk's statistical utilities to store on the server. Also specify 
whether they should be compressed and sent to an e-mail address after 
processing. 

5 Click OK. 

 

To view the contents of a log file or download it to your computer, click the  Log Manager 
icon in the Hosting group. A list of log files will show. 

 To specify the number of lines from the end of the log file that you would like to view, type 
a number into the input box under the Preferences group. 

 To view the contents of a log file, click its file name.  

 To download a file to your computer, click an icon  corresponding to the file you need.  

 To remove a processed log file from the server, select a corresponding check box, click  
Remove Selected, confirm removal and click OK. 
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With the current version of backup and restore utilities installed with your control panel, you 
can: 

 Back up your domain (Web site). The backup archive will include all data related to your 
account (except for resource allotments and permissions to perform operations within the 
control panel), domain (web site) and mail services, including the contents of mailboxes, 
Horde Turba address book contact lists, anti-spam and anti-virus settings. 

 Schedule backups.  
 Restore your data from backup archives. 

You can access your backup repository via your Home page (Home > Backup). 

In This Chapter 
Backing Up Your Domain .................................................................................................... 91 
Scheduling Backups.............................................................................................................. 91 
Restoring Data From Backup Archives ................................................................................ 92 
Maintaining Your Backup Files Repository.......................................................................... 92 
Configuring Control Panel for Using FTP Repository.......................................................... 94 
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Backing Up Your Domain 
 To back up your domain (web site): 

1 Click the  Back Up icon in the Domain group. 
2 If you want to back up and store the backup file on an FTP server, click the 

FTP repository tab, then click FTP Account Properties to specify the destination 
FTP server (as described in the Configuring Control Panel for Using FTP 
Repository (see page 94) section), if you have not done so yet. 

3 Click the  Backup Now icon in the Tools group. 
4 Specify the backup file name and give a description to the backup file. 
5 To create a multivolume backup, select the respective check box and specify 

volume size in megabytes. 
6 Select the repository where you would like to store the backup file. 
7 Click Back Up Now. 
8 The backup will start and the progress will be shown.  

 To update the information on the screen, click  Refresh. 

 To cancel the backup, click Cancel and confirm the cancellation by clicking OK. 

9 Upon completion of the backup process you will be shown a window 
displaying the backup results, including errors, if they were encountered. 
Click OK. 

The backup file will be saved to the repository you selected, and will be accessible either from 
the FTP server, or from the location Home > Backup. 

Scheduling Backups 
 To schedule backup of your domain (web site): 

1 Click the  Backup icon in the Tools group. 

2 Click the  Schedule Backup icon in the Tools group. 
3 Specify when and how often to perform backup. 
4 To enable recycling of backup files, deselect the Unlimited check box and 

type the maximum allowed number of files in the repository.  
When this limit is reached, the oldest backup files are removed. 

5 Specify the combination of symbols that backup file names should begin 
with.  
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This will help you distinguish between backup files. 

6 Select the repository where you would like to store the backup file. 
7 To create a multivolume backup, select the respective check box and specify 

volume size in megabytes. 

8 Click the  Enable icon in the Tools group. 
9 Click OK. 

 
 

Restoring Data From Backup Archives 
 To restore your domain (Web site): 

1 Click the  Backup icon in the Tools group. 
2 If you wish to restore data from a file stored on an FTP server, click the FTP 

Repository tab. 
3 Click the backup file name you need. 
4 Click Restore Now. 

 To update the information on the screen, click  Refresh. 

 To cancel the restoring process, click Cancel and confirm the cancellation by clicking 
OK. 

5 Upon completion of the restoring process you will be shown a window 
displaying the restoration results, including errors, if they were encountered.  

6 Click OK. 

 
 

Maintaining Your Backup Files Repository 
This section provides instructions on: 

 Uploading backup files stored on another computer. 
 Downloading backup files to another computer. 
 Removing redundant backup files from the backup repository. 
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Uploading Backup Files to Server 
 To upload a backup file to the control panel's backup repository: 

1 On your Home page, click the  Backup icon in the Tools group. 
2 Click Upload Files to Local Repository. 
3 Click Browse and select the required backup file. 
4 Click OK. 

The backup file will be uploaded to the backup repository. 
 

Downloading Backup Files from Server 
 To download a backup file from the control panel's backup repository: 

1 On your Home page, click the  Backup icon in the Tools group. 
2 Click the  icon corresponding to the backup file you wish to download. 
3 Select the location where you wish to save the backup file and click Save. 

The backup file will be downloaded from the backup repository. 
 

Removing Backup Files from Server 
 To remove a backup file from the control panel's backup repository: 

1 On your Home page, click the  Backup icon in the Tools group. 
2 Select a check box corresponding to the backup file you wish to remove. 
3 Click  Remove Selected.  
4 Confirm removal and click OK. 
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Configuring Control Panel for Using FTP 
Repository 

If you are going to use an FTP server for storing backup files, you should set up the control 
panel appropriately: 

1 Go to Home > Back Up > FTP Repository  > FTP Account Properties. 
2 Specify the following properties: 

 FTP server's IP address or host name. 

 Directory on the server, where you want to store backup files. 

 User name and password for access to the FTP account. 

3 Click OK. 
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If you need to run scripts on your site at specific time, use the task scheduler on your provider's 
server to make the system automatically run the scripts for you. 

In This Chapter 
Scheduling a Task ................................................................................................................. 96 
Suspending and Resuming Execution of Tasks .................................................................... 97 
Unscheduling a Task ............................................................................................................. 97 
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Scheduling a Task 
 To schedule a task: 

1 On your Home page, click the  Crontab icon in the Hosting group. 

2 Click  Add New Task. 
3 Specify when to run your command. 

 Minute - enter the value from 0 to 59 

 Hour - enter the value from 0 to 23 

 Day of the Month - enter the value from 1 to 31 

 Month - enter the value from 1 to 12, or select the month from a drop-down box 

 Day of the Week - enter the value from 0 to 6 (0 for Sunday), or select the day of the 
week from a drop-down box 

You can schedule the time using the UNIX crontab entry format. In this format, you can 

 enter several values separated by commas. Two numbers separated by a hyphen mean an 
inclusive range. For example, to run a task on the 4th, 5th, 6th, and 20th of a month, 
type 4-6,20. 

 insert an asterisk to specify all values allowed for this field. For example, to run a task 
daily, type * in the Day of the Month text box. 

To schedule the task to run every Nth period, enter the combination */N, where N is the 
legal value for this field (minute, hour, day, month). For example, */15 in the Minute field 
schedules the task to start every 15 minutes.  

You can type the contracted names of months and days of the week, which are the first three 
letters: Aug, Jul, Mon, Sat, etc. However, the contracted names cannot be separated with 
commas or used together with numbers. 

4 Specify which command to run. Type it into the Command input box. 
5 Click OK. 
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Suspending and Resuming Execution of 
Tasks 

 To temporarily suspend execution of scheduled task: 

1 On your Home page, click the  Crontab icon in the Hosting group. 
2 Choose a task that you wish to suspend and click on the command name. 

3 Click the  Disable icon. 

 

 To resume execution of scheduled task: 

1 On your Home page, click the  Crontab icon in the Hosting group. 
2 Choose a task whose execution you wish to resume and click on the 

command name. 

3 Click the  Enable icon. 

 
 

Unscheduling a Task 
 To unschedule a task: 

1 On your Home page, click the  Crontab icon in the Hosting group. 
2 Select a check box to the right of the task that you wish to unschedule. 
3 Click  Remove Selected. 
4 Confirm removal and click OK. 
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In This Chapter 
Monitoring Connections to Control Panel ............................................................................ 98 
Monitoring Connections to FTP Service............................................................................... 99 
 
 

Monitoring Connections to Control Panel 
 To find out who of your customers is logged in to the control panel at the moment: 

1 Click Sessions in the navigation pane. All sessions including yours will be 
presented and the following details will be displayed: 
 Type. A type of control panel user who established the session:  

 for domain or Web site owner. 

 for mailbox owner. 

 Login. The login name the user is logged in as. 

 IP address. The IP address from which the control panel is accessed. 

 Logon time. The date and time when the user logged in to the control panel. 

 Idle time. The time that user was not doing anything in the control panel while being 
logged in. 

2 To refresh the list of user sessions, click the  Refresh icon. 
3 To end a user session, select the respective check box and click  Remove 

Selected, then confirm removal and click OK. 
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Monitoring Connections to FTP Service 
To find out who is connected to your server via FTP, in what directories they currently are and 
what files they are uploading to or downloading from the server: 

1 Click Sessions in the navigation pane. 
2 Click the FTP Sessions tab. All sessions including yours will be presented 

and the following details will be displayed: 
 Type. The type of user who established the session:  

 for users not registered with the control panel. 

 for anonymous FTP users. 

 for domain or web site administrators. 

 for subdomain administrators. 

 for web users (owners of personal web pages without individual domain names). 

 Status. The current status of FTP connection. 

 FTP user login. The login name used for access to FTP account. 

 Domain name. The domain the FTP user is currently connected to. 

 Current location. The directory the FTP user is currently at. 

 File name. The file name being operated on. 

 Speed. Transfer speed in kilobytes. 

 Progress, %. The file transfer operation progress in percentage. 

 IP address. The IP address from which the FTP account is accessed. 

 Logon time. The time lapsed since the moment user logged in. 

 Idle time. The time that user was not doing anything while being connected to the server 
through FTP. 

3 To refresh the list of FTP sessions, click  Refresh. 
4 To end a session, select the respective check box and click  Remove 

Selected. 
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If your service provider offers a Help Desk solution integrated with the control panel, then you 
can use it to report your problems to your provider’s technical support staff. 

In This Chapter 
Submitting a Problem Report to Your Service Provider....................................................... 100 
Commenting and Closing Your Trouble Ticket.................................................................... 101 
 
 

Submitting a Problem Report to Your Service 
Provider 

 To submit a new problem report to your service provider: 
1 Click the Help Desk shortcut in the navigation pane. 

2 Click the  Add New Ticket icon in the Tools group. 
3 Type the ticket subject, select the category the issue is related to, and type 

in the problem description. 
4 Click OK.  

The ticket is now submitted to the system and sent to your provider. You will be notified by 
e-mail when the issue is resolved. 

 

C H A P T E R  1 2  

Using Help Desk for Requesting 
Assistance From Service Provider 



 

 Using Help Desk for Requesting Assistance From Service Provider 101 
 

Commenting and Closing Your Trouble Ticket 
 To post a new comment or to close a ticket: 

1 Click the Help Desk shortcut in the navigation pane. 
2 Locate the ticket you need and click its subject or identification number. 
3 To close, reopen or post a comment to the ticket, select the operation you 

would like to perform from the Ticket Event drop-down box, and type a new 
comment into the New Comment input field if required. 

4 Click OK to submit. 
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